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                                Latest Updates 
----------------------------------------------------------------------------- 
Version = 1.1.8.4 
Build date = April 2020 
ESS Level = LCD8-2010-24 
 
Here are a couple options for obtaining a no-cost version of Java: 
    https://adoptopenjdk.net/ 
    https://aws.amazon.com/corretto/ 
     
--------------------------------- 
1. Enhancements to Run SQL Scripts: 
   - SQL language and performance improvements to Content Assist. 
   - Content Assist preferences support, including description text and data 
type. 
   - Display timestamp of query in results window.   (RFE 134636) 
   - Details... action added on query result.        (RFE 134635) 
   - Option to Suppress Inquiry Messages.            (RFE 140075)  
   - New entries in Insert from Examples for all new IBM i Services. 
2. Enhancements to Database Schemas: 
   - SQL Weak Type support. 
   - SQL table comparison support. 
3. Data Transfer Enhancements: 
   - Column heading and label options added to CLDOWNLOAD.  (RFEs 138673, 
138915) 
4. Enhancements to 5250 Display and Print emulation: 
   - Compatible pasting of special characters from other Windows documents. 
     See GettingStarted section 9.6.6 5250 Compatibility.   (RFE 126146) 
   - Utility to generate the font-image file for User Defined Characters with 
     PDT printing on a Windows workstation.                 (RFE 130267) 
   - Easier way to create a shortcut to a 5250 session.     (RFE 132157) 



     Session Manager, File->Open Directory will open the location of the 
configuration files. 
     From there, a shortcut or alias can be manually created. 
   - Option on Print Screen Setup to set column separators. (RFE 128192) 
   - Capability to reorder a print screen collection.       (RFE 114927) 
   - Option to "Disable the popup keypad menu".             (RFE 140004) 
     Available at 5250 Session Manager-->Tools-->Customize Menu Bar...    
   - Allow "Yen" and "Backslash" at the same time.          (RFE 132374) 
   - Maintain selection in 5250 Session Manager when a 5250 session exits. 
(RFE 131959) 
   - Option to save screen images from a Screen History Archive.           
(RFE 123233) 
5. Open Source Package Management (OSPM) Enhancements 
   - Install RPM-based open source packages on an IBM i partition not 
connected to the internet. 
     An SSH tunneling option allows internet access to the RPM repository 
through the connected workstation. 
   - Maintain a list of recently used locations.            (RFE 138815) 
   - Clear Metadata... action added to Utilities. 
6. Enhancements to System Configurations: 
   - Features that leverage SSH connections (eg OSPM, SSH Terminal) can 
     configure a different port at System Configurations->Connection.  (RFE 
140483) 
   - Button on System Configurations Console tab to verify connections (RFE 
128193) 
7. Other General Enhancements: 
   - Splash screen displays until first panel appears.      (RFE 139134) 
   - Several most-recently-used lists have been added       (RFE 89715)  
   - Access the internet from an SSH Terminal on an IBM i partition not 
connected to the internet. 
     See the HttpProxyUI plugin in GettingStarted. 
 
This update includes several fixes including: 
 
APAR SE72681 OSP-INCORROUT ACS SCHEMAS TABLES DEFINITION ADDING A COLUMN 
REQUIRES MORE TAB-KEYS TO FILL  
APAR SE72751 OSP ACS 5250 PASTE WILL ADD AN EXTRA LINE   
APAR SE72831 OSP-PAR-940XMISC WAIT SCREEN WHEN TRYING FOR VIEW TABLES OR 
JOURNALS IN ACS 1.1.8.3 DATABASE CONTAINER 
APAR SE72870 OSP-INCORROUT USING ACS PRINTER SESSION WITH PDT IBM5577-
B02,F02,G02,H02 AND APW SYMBOL FUNCTION  
APAR SE72873 OSP-UNPRED ACS - TEXT ON PANELS NOT TRANSLATED TO THE SELECTED  
LOCALE 
APAR SE72879 OSP-UNPRED DATA TRANSFER FIELDS SPECIFIED AFTER AN ENTER TO GET 
A NEWLINE ON CHANGE DATA OPTIONS ARE NOT SHOWN   
APAR SE72883 ACS RPM CLONING FAILS  
APAR SE72913 MSGMSGDB0036 [SQL0104] TOKEN (WAS NOT VALID.   
APAR SE72951 OSP-INCORROUT WRONG BEHAVIOR WHEN USING ACS 5250 SESSION HOST 
CODE PAGE 424 AND DDS FLDCSRPRG   
APAR SE72984 OSP-UNPRED ACS KEYBOARD DOCUMENTATION INCORRECT   
APAR SE72991 OSP-INCORROUT QUERY/400 STATUS MESSAGES ARE VERY SLOW USING ACS 
5250 EMULATION SSL ENABLED. 
APAR SE72992 OSP-INCORROUT HANG PROBLEMS USING ACS 5250 SESSION WITH HOST 
CODE PAGE 424 AND DDS FLDCSRPRG   
APAR SE73042 OSP-INCORROUT ACS CURSOR PROBLEMS WITH DDS KEYWORD RLTB 
APAR SE73069 OSP-PAR-940XMISC ACCESS CLIENT SOLUTIONS ACS JAVA PRINT SERVICE 
JPS BESTFIT OPTION RESULTS ARE INCONSISTENT   



APAR SE73145 LOSING CURSOR ON 5250 EMULATION SESSION  
APAR SE73163 OSP ACS 5250 PASTING DATA IN A DBCS ENVIRONMENT MIGHT ADD EXTRA 
CHARACTERS.  
APAR SE73264 OSP-THREADS-UNPRED ACS RSS UNABLE TO ENTER CHARACTER UCP 00E2  
APAR SE73344 OSP-MSGCPDA4A8 ERROR 8925 CREATION OF DEVICE FAILED WHEN 
SELECTING PRINTER MODEL INFOPRINT 650ES (EPSON MODE) OR (PPDS  
APAR SE73391 ACS TAKES A LONG TIME TO LOAD WHEN LAUNCHED ON OVER NETWORK. 
APAR SE73392 ACS 5250 EMULATION IS STARTING MUCH SLOWER WHEN THE BASE 
DIRECTORY CONFIGURATION CONTAINS A UNC PATH.  
APAR SE73414 WHEN LAUNCHING A 5250 MULTIPLE SESSION BATCH FILE THE SIGNON TO 
IBM I PROMPT PANELS MAY BE PARTIALLY BLANK 
                                 
----------------------------------------------------------------------------- 
Version = 1.1.8.3 
Build date = December 2019 
ESS Level = LCD8-2010-23 
 
Note: This version requires Java 8. To ensure uninterrupted usage, make sure 
your deployment is using Java 8 before deploying this version. 
      To check which version of Java is being used by IBM i Access Client 
Solutions, select Help->About from the product's main panel. 
 
Here are a couple options for obtaining a no-cost version of Java: 
    https://adoptopenjdk.net/ 
    https://aws.amazon.com/corretto/ 
     
--------------------------------- 
1. Enhancements to Run SQL Scripts: 
  - Availability of Content Assist (RFEs 96285, 112116, 115073, 123901) 
  - Option in status bar for downloading additional rows (RFE 124799) 
  - Save custom examples using Edit->Examples->Save as New Example... (RFE 
103463) 
  - Additional directory support for examples at Edit->Examples->Insert from 
Examples... , Preferences... 
  - Display cursor coordinates in status bar 
  - Syntax highlighting updates 
  - Insert from Examples enhanced for new IBM i Services 
2. SQL Performance Center 
  - Display confirmation message prior to deleting an active monitor ( RFE 
130146 ) 
3. Enhancements to Database Schemas: 
  - Search capability using Edit->Find 
  - Support for TRUNCATE TABLE 
  - Constraint Definition dialogs show status 
  - List the nodes below each schema in alphabetical order (RFE 137014 ) 
4. Miscellaneous Visual Explain improvements  
5. Enhancements to Integrated File System: 
   - Add "Open in Run SQL Scripts" action for .sql files 
   - Add "Explain SQL" action for programs 
6. Enhancements to System Configurations: 
   - Additional Hardware Management Interfaces on the provided list of 
candidates (RFE 134333, 134973) 
     Note the following incompatibility: 
     Since Tape Management 2 was added, the Tape Management plugin was 
renamed from tapemgmt to tapemgmt1 (reference GettingStarted). 
7. Data Transfer Enhancements: 
   - Additional option for com.ibm.iaccess.dataxfer.SheetId (RFE 135210) 



8. Other General Enhancements: 
   - Check and download updates from an IBM i system.  See GettingStarted 
section 5.2 Setting up an IBM i Update Location. 
   - Import and View Personal Certificates using Key Management (RFE 128331) 
   - The default user id will no longer be switched when changing passwords 
   - Set default action on ACS Window Setup Panel (RFE 137693) 
 
This update includes several fixes including: 
 
APAR SE71175 OSP-OTHER-INCORROUT USING ACS TO RESTART AN IDENTITY COLUMN 
FAILS WITH MSGSQL0199 DUE TO MISSING SET KEYWORD                   
APAR SE71212 OSP SQL FORMAT IN ACS GETS NULLPOINTEREXCEPTION                                                                                    
APAR SE71213 OSP SAVE PROMPTING IN ACS DOES NOT WORK AS EXPECTED.                                                                               
APAR SE71223 OSP-OTHER-INCORROUT ACS DELETING INDEX ADVISES MAY FAIL WITHOUT 
AN ERROR                                                           
APAR SE71224 OSP-OTHER-INCORROUT ISSUE WITH EDIT-PASTE FUNCTION IN IACS 
V1.1.8.2 5250 EMULATOR.                                            
APAR SE71255 OSP-INCORROUT FILTER FOR SPECIFY USER DATA FIELD IN PRINTER 
OUTPUT IN IBM I ACCESS CLIENT SOLUTIONS DOE NOT HONOR LOWER CASE   
APAR SE71299 OSP-INCORROUT GRID LINE NOT DISPLAYED IN ACS WHEN USING DSPF 
WITH DDS GRDLIN OR GRDBOX                                          
APAR SE71300 OSP ACS IMPORTED MACRO WILL FAIL WITH " MACRO WAS EMPTY " IF THE 
OLD PC5250 / PCOM MACRO CONTAINS & OR < OR " CHARACTER.        
APAR SE71321 OSP-UNPRED ACS DBCS COBOL PROGRAM FAILS WITH MCH0603                                                                               
APAR SE71388 OSP ACS HARDCOPY LOCAL PRINT FUNCTION WILL GENERATE A PRINTOUT 
WITH THICK LINES.                                                  
APAR SE71392 OSP-UNPRED ACS GRID LINES REMOVED USING CLEAR FIELDS FUNCTION                                                                      
APAR SE71396 OSP ACS 5250 EMULATION WILL DISPLAY WRONG DATA IF DATA IS 
DELETED IN CNTFLD FIELD                                                                                                                      
APAR SE71413 OSP-INCORROUT ACS DDS WINDOW PROBLEMS                                                                                              
APAR SE71458 OSP-UNPRED ACS BACKUP SERVER NOT WORKING CORRECTLY                                                                                 
APAR SE71462 OSP-INCORROUT POP UP KEYPAD STAYS ACTIVE AFTER SELECTING CUSTOM 
MENU FUNCTION                                                      
APAR SE71471 OSP-UNPRED ACS SHIFT TAB MOVES CURSOR TO NON DISPLAY FIELDS                                                                        
APAR SE71504 OSP-UNPRED ACS SHIFT TAB MOVES THE CURSOR TO AN UNINTENDED 
POSITION ON THE EDTWRD FIELD                                       
APAR SE71617 OSP DIFFERENT BEHAVIOUR BETWEEN OLD EHLLAPI OF CLIENT ACCESS AND 
THE NEW EHLLAPI OF ACCESS CLIENT BRIDGE                        
APAR SE71668 OSP-UNPRED DATA TRANSFER TRUNCATE TRAILING SPACES NOT DONE 
CORRECTLY                                                          
APAR SE71699 OSP-OTHER-INCORROUT ACS SAVING SQL SCRIPT RESULT AS OPENOFFICE 
ODS RESULTS IN DATE COLUMN SHOWN WITH TIME                         
APAR SE71820 OSP-INCORROUT MODIFY OPTION IN SESSION MANAGER DOES NOT SAVE 
CHANGES.                                                           
APAR SE71880 OSP-OTHER-INCORROUT ACS RSS EXPORT NCHAR AND GRAPHIC CCSID 1200 
NOT SUPPORTED IN ANY FORMAT EXCEPT EXCEL                           
APAR SE71906 OSP ACS 5250 EMULATION MIGHT LOOK LIKE HANGING WHEN THE USERS 
ARE TYPING VERY FAST                                               
APAR SE71950 INCORROUT-HLIC-94XXMISC ACS PROFILE MIGRATION TOOLS DOES NOT 
CONVERT SSL SETTTING.                                              
APAR SE71955 OSP ACS 5250 SESSION INPUT INHIBITED WHEN USING LARGE SUBFILE, 
MENU WITH BUTTONS                                                  
APAR SE71971 OSP-INCORROUT DDS SNGCHCFLD WITH KEISEN BUFFER INCORRECTLY 
DISPLAYED WHEN USING ACS EMULATOR                                  
APAR SE72063 OSP-UNPRED ACS NO DATA AVAILABLE ON REORGANIZE WHILE THE 
REORGANIZATION IS SUCCESSFUL                                       



APAR SE72129 OSP-UNPRED AUTO STARTING MACRO USING HOST ID METHOD RETURNS 
INCORRECT HOST ID IN A BATCH SESSION FILE WITH MULTIPLE SESSIONS   
APAR SE72147 OSP-UNPRED UNABLE TO VIEW JOB SPECIFIC AUDIT DATA VIA ACS                                                                          
APAR SE72159 OSP-UNPRED INCORRECT CURSOR POSITION AFTER ENTERING DBCS DATA IN 
INPUT FIELD                                                     
APAR SE72303 OSP ACS RUN SQL SCRIPT MIGHT HANG                                                                                                  
APAR SE72384 OSP-UNPRED TYPING DBCS DATA ON AN INPUT FIELD MOVES THE CURSOR 
TO THE END OF THE FIELD INSTEAD ON TO THE NEXT INPUT FIELD         
APAR SE72430 OSP-UNPRED ACS NEED REPEATEDLY DO SHIFT SPACE TO SWITCH TO 
FULLWIDTH 
APAR SE72576 OSP-UNPRED CHANGED PRINTER NAME ON PRINT SCREEN SETUP NOT SAVED 
APAR SE72684 OSP ACS CONVERSION PROBLEMS WITH SPECIAL GERMAN PDT PRINTER 
SESSIONS USING HOST CODE PAGE 1141.     
APAR SE72746 OSP-INCORROUT ACS EMULATOR LEAVES TRIM BOX BEHIND ON FIELD WITH 
MOUBTN EVENT. 
APAR SE72768 SPLF PLUGIN FROM SHARED CENTRAL DEPLOYMENT OF KERBEROS 
CONNECTION WHEN NOT ENROLLED IN KERBEROS                                                    
 
----------------------------------------------------------------------------- 
Version = 1.1.8.2 
Build date = April 2019 
ESS Level = LCD8-2010-22 
 
Note: This version requires Java 8. To ensure uninterrupted usage, make sure 
your deployment is using Java 8 before deploying this version. 
      To check which version of Java is being used by IBM i Access Client 
Solutions, select Help->About from the product's main panel. 
 
Here are a couple options for obtaining a no-cost version of Java: 
    https://adoptopenjdk.net/ 
    https://aws.amazon.com/corretto/ 
     
--------------------------------- 
1. Enhancements to Run SQL Scripts: 
   - A completely redesigned SQL formatter which understands complex SQL, 
provides consistent formatting, and detailed error reporting. (RFEs 94205, 
100221) 
   - Run SQL statements using IBM i Source physical Files (RFE 95556) 
   - Run SQL statements using stream files in IFS (RFE 130016) 
   - Connect with last used database and IASP (RFE 131741) 
   - More Insert from Examples 
   - Additional JDBC connection properties for assigning alternate server 
name and other attributes. 
   - Support languages with bidirectional data (RFE 127738) 
2. Enhancements to Database Schemas: 
   - Copy/Paste provides an easy way to establish new projects. 
3. Enhancements to Printer Output: 
   - Option to remove system name from the download path (RFE 128478) 
4. Enhancements to Integrated File System: 
   - Added action Download... to temporarily override download location set 
in preferences (RFE 123485) 
   - Added Include filter to improve performance by limiting data returned 
from the server. (RFE 130007) 
5. Enhancements to System Configurations: 
   - Actions may be launched directly from the System Configuration panel 
using either the menu, context menu (right-click), or keyboard shortcut. 



   - Up to six Hardware Management Interfaces may be configured from a 
provided list of candidates.  The main ACS panel will be updated accordingly. 
   - Columns rearranged so Description is next to System Name. 
5. Configuration Enhancements: 
   - Added property com.ibm.iaccess.IncludeComps so administrators can 
specify a static list of available ACS features (RFE 97999) 
   - Property com.ibm.iaccess.ResetDefaultUserOnImport can be used to reset 
the default user id when importing a configuration (RFE 123946) 
6. Other General Enhancements: 
   - Japanese new era support 
   - For environments like Citrix, property 
com.ibm.iaccess.ResetForMaintenanceOnExit can be used to end all ACS 
processes when ACS exits (RFE 130431) 
 
This update includes several fixes including: 
 
APAR SE70280  OSP-THREADS-INCORROUT INCORRECT BEHAVIOR WITH ACS USING BYPASS 
SIGNON IN MULTIPLE SESSIONS TO THE SAME SYSTEM.                  
APAR SE70283  OSP-UNPRED OVERWRITING DATA ON A CNTFLD KEYWORD FOR THE TYPE J 
FIELD ADDS SHIFT IN AND SHIFT OUT                                 
APAR SE70295  OSP ACS 5250 EMULATION SELECTING SEVERAL ITEMS IN A MENU MIGHT 
NOT BE POSSIBLE.                                                   
APAR SE70307  UNPRED-HLIC ACS FILE SYSTEM SEND OPTION ONLY WORKS WITH .FILE  
OBJECTS                                                            
APAR SE70351  OSP-UNPRED INCORRECT CURSOR MOVEMENT EDITING A SOURCE FILE WITH 
DBCS CHARACTER CONTENT                                             
APAR SE70402  OSP-INCORROUT X22 APPEARS TO BE TRANSFORMED TO BLANK, BUT IT'S 
GETTING OFFSET N+1 X22 IS WHITE COLOR FOR COMMENTS IN RPG.         
APAR SE70403  OSP-UNPRED REOPENING A SAVED SESSION WITH MINIMIZED SCRATCH PAD 
SCRATCH PAD IS OPENED AND NOT MINIMIZED.                           
APAR SE70415  OSP-INCORROUT ACS EXCEL FILE TO IBM I FILE TRANSFER DECIMALS 
ARE INCORRECT                                                      
APAR SE70416  OSP ACS ACSLAUNCH WIN-32.EXE WILL FAIL TO START WHEN USING JAVA 
11 32BIT FROM ADOPTOPENJDK                                         
APAR SE70456  OSP-FILE NAME IN WINDOWS PRINT QUEUE DIFFERENT WHEN USING ACS 
JAVA PRINT SERVICE                                                 
APAR SE70463  OSP-UNPRED ILLEGAL SHIFT CHARACTERS ARE ADDED WHEN THE 
CHARACTER TRANSITS TO THE SECOND LINE IN THE O TYPE CNTFLD         
APAR SE70464  OSP-UNPRED DDS CNTLFLD KEYWORD DBCS CHARACTERS WILL NOT TRANSIT 
TO THE FIRST LINE WHEN USING DELETE                                
APAR SE70467  OSP-UNPRED DDS SCREEN SHOWS GARBLED DBCS TEXT                                                                                      
APAR SE70468  OSP-UNPRED ACS NEW TAB OPENS IN A SMALL AREA OF THE SCREEN WHEN 
TAB BAR IS NOT SHOWN                                               
APAR SE70511  OSP ACS MIGHT ASK FOR A SECOND TIME FOR USER ID AND PASSWORD                                                                       
APAR SE70538  OSP-INCORROUT SARA-AM THAI FONT PRINTS INCORRECTLY USING ACCESS 
CLIENT SOLUTIONS PRINTER SESSION USING JAVA PRINT SERVICE          
APAR SE70540  OSP-INCORROUT ACS DATA TRANSFER OF TIMES TO EXCEL                                                                                  
APAR SE70545  OSP-UNPRED ACS USING RESTRICT PLUGIN WITH DATAXFER GROUP 
REPORTS MSGRST001 FOR DTBATCH                                      
APAR SE70554  OSP-UNPRED ACS SHOW RESTRICTED FUNCTIONS SCREEN SEEN BY USERS                                                                      
APAR SE70584  OSP IN PERFORMANCE MONITORS AND SELECTING DBMONS TO DELETE THE 
START OF THE SELECTION CAN BE LOST CAUSING ALL DBMONS TO DELETE.   
APAR SE70591  OSP-INCORROUT-CRT PASTE INTO 5250 SESSION INCORRECT. CHARACTERS 
CUT OFF AT END OF LINE RATHER THAN WRAP TO NEXT LINE.              
APAR SE70600  OSP-ACCESS CLIENT SOLUTIONS ADD PDT SUPPORT FOR EXTENDED                                                                           
APAR SE70665  UNPRED-HLIC WHEN MULTIPLE RDP SESSIONS ARE STARTED BY ONE USER, 
ALL 5250 SESSIONS LAUNCH ON FIRST RDP SESSION.                     



APAR SE70680  ACS ESC_P PDT INCORRECT OUTPUT                                                                                                     
APAR SE70806  OSP ACS MULTIPLE SESSION OF LAUNCHER IN A BATCH PROCESS MIGHT 
RESULT IN MSGGEN045 AND 659 AT THE SESSION                         
APAR SE70842  OSP ACS DATA TRANSFER ACTIVE SPREADSHEET WAS NOT FOUND OR CELL 
BEING EDITED                                                       
APAR SE70861  OSP ACS IMPORTING THE SETTING FOR THE "ENABLE TOOL TIP MESSAGE" 
FROM A ACS_BAK.ZIP DID NOT WORK                                    
APAR SE70890  OSP ACS PLUGIN 5250 MIGHT NOT HONOR THE /SYSTEM=XXXX PARAMETER 
IF A ACSDISPLAY.HOD IS AVAILABLE 
APAR SE70945  ACS PDT ROMAN NUMERAL / JIS CODE CANNOT BE PRINTED CORRECTLY 
APAR SE71063  WHEN WRITING THE DDS-WINDNOW RECORD, THE CHARACTERS IN THE 
BACKGROUND ARE DISCOLORED GARBAGE 
APAR SE71412 OSP-INCORROUT ACS PC5250 TOOLBAR FILE MIGRATION PROBLEMS                                
 
          
      
----------------------------------------------------------------------------- 
Version = 1.1.8.1 
Build date = November 2018 
ESS Level = LCD8-2010-21 
 
Note: This version requires Java 8. To ensure uninterrupted usage, make sure 
your deployment is using Java 8 before deploying this version. 
      To check which version of Java is being used by IBM i Access Client 
Solutions, select Help->About from the product's main panel. 
 
Recommended Java Level: Java 8 Update 191 or higher 
--------------------------------- 
1. Enhancements to Run SQL Scripts: 
   - "for update" now allows results to be updated (RFE 89794) 
   - Ability to select text from within a result cell (RFE 91124) 
   - Support for displaying name and label at the same time  (RFE 98618) 
   - Support for changing column headings in current results (RFE 108357) 
   - Support for column customization in current results (RFE 125506) 
   - Refresh option to update current results (RFE 108617) 
   - Many new Insert from Examples 
2. Enhancements to Database Schemas: 
   - Specifying a system name is supported when creating a new schema 
   - Improvements to Tables->Work with->Related Objects 
   - Added support for changing Aliases, Row Permissions, and Column Masks 
3. Enhancements to SQL Performance Center: 
   - Support for filtering Performance Monitors, Plan Cache Snapshots, and 
Plan Cache Event Monitors. 
4. General DB Enhancements: 
   - Added File->New Window to Schemas and SQL Performance Center for 
selecting a different system (RFE 119563) 
5. Enhancements to 5250 Display and Print emulation: 
   - Allow keyboard buffering to be turned off  (RFE 91890) 
   - Allow variables in Print Screen Header and Footer (RFE 92158) 
   - Migrate kerberos setting from Access for Windows to ACS (RFE 122787) 
   - Enable margin setting for 5250 print emulation when Use Java Print 
Service is specified (RFE 122569) 
6. Enhancements to Data Transfer: 
   - Custom tab names for Excel download (RFE 112968) 
   - UTF-8 support for Dos Random file type (.dsr) 
     See additional information below for incompatibility with previous 
versions 



7. Other General Enhancements: 
   - Installation scripts for Windows check for compatible version of Java 
 
Attention: Users of Data Transfer: 
This update includes changes that make Data Transfer downloads and uploads 
using the Dos Random format (.dsr) incompatible with previous versions unless 
you take the actions outlined below.  Other file formats (.csv, .txt, .xlsx, 
.ods, etc) are not affected.  The default File Encoding for Data Transfer 
downloads and uploads is UTF-8.  The File Encoding determines how the 
downloaded data is formatted within the .dsr file.  Previous versions of ACS 
were not correctly formatting a DosRandom file format when a UTF-8 encoding 
was specified.  Instead, the DosRandom file format was always being formatted 
according to a US-ASCII encoding.  Any saved Data Transfer request files 
(.dtfx, .fdfx, .dttx) likely have the encoding as UTF-8 (which would be 
incorrect since the encoding for dsr files was always US-ASCII). 
Because it is necessary to support characters which cannot be represented by 
US-ASCII, this update will honor the FileEncoding as specified.  That means 
if you want to continue to use the US-ASCII format, you will need to make the 
following changes: 
1. For new download requests, visit the Details panel and change the 
"Translate system data to" to US-ASCII.  The default is UTF-8. 
2. If you have saved Data Transfer download requests (file type dtfx and 
fdfx) for Dos Random, you will need to change the FileEncoding property from 
UTF-8 to US-ASCII. 
3. If you have saved Data Transfer upload requests (file type dttx and fdfx) 
for Dos Random, you will need to change the FileEncoding property from UTF-8 
to US-ASCII. 
 
 
This update includes several fixes including: 
 
APAR SE69687  OSP-INCORROUT LEFT ARROW TO MOVE CURSOR FROM A TYPE TO G TYPE  
DOESN'T CHANGE TO DOUBLE WIDTH CURSOR.  RIGHT ARROW WORKS.         
APAR SE69690  OSP-PAR-940XCOM JPS PAPER SIZE SETTING IS USING THE WINDOWS  
DEFAULT DRIVER PAGE SIZE SETTING.                                 
APAR SE69730  OSP-UNPRED PRINT THE CURRENT SCREEN EXTRANEOUS COPY OF THE SAME 
SCREEN ARE RANDOMLY PRINTED WHEN DONE QUICKLY                     
APAR SE69743  OSP ALTERING A COLUMN TO BE IMPLICITLY HIDDEN WITH ACS WILL 
FAIL WITH SQL0104.                                                
APAR SE69745  OSP-THREADS-UNPRED KMP, BAR AND PMP FILES DELETED DURING 
MIGRATION.                                                        
APAR SE69761  OSP-PAR-940XCOM ACCESS CLIENT SOLUTIONS JAVA PRINT SERVICES 
'GRID RULE LINES' IS MISSING                                      
APAR SE69787  UNPRED-HLIC-94XXCOM UP AND DOWN ARROW KEY MOVEMENTS ARE 
DIFFERENT FROM IAW.                                               
APAR SE69794  OSP-PAR-940XCOM JAPANESE EXTENDED SHIFT_JIS SPECIAL CHARACTER 
NOT PRINTED THROUGH ACCESS CLIENT SOLUTIONS PRINTER SESSION       
APAR SE69803  OSP-UNPRED INCORRECT DATA DUE TO DATA TRANSFER UPLOAD WITH DSR 
FORMAT                                                            
APAR SE69806  OSP-INCORROUT WRONG POSITION IME CONVERSION CANDIDATE WINDOW 
WITH ACS                                                          
APAR SE69831  OSP-PAR-940XCOM JAPANESE EXTENDED SHIFT_JIS SPECIAL CHARACTER 
NOT PRINTED THROUGH ACCESS CLIENT SOLUTIONS PDT PRINTER SESSION   
APAR SE69845  INCORROUT-PRT-ACS PRINTER SESSION USING JAVA PRINT SERVICES 
V1.1.8 THAI CHARACTERS PRINT INCORRECTLY                          
APAR SE69846  INCORROUT-ACS V118 EXTRA FILE GENERATED IN PDF DRIVER WINDOWS 
PRINT QUEUE USING JAVA PRINT SERVICE                              



APAR SE69888  OSP-ACCESS CLIENT SOLUTIONS INTERVENTION REQUIRED MESSAGE 
ISSUED IN PRINTER SESSION USING WINDOWS 10 AND JAVA 10            
APAR SE69900  OSP ACS START MIGHT FAIL WITH 
JAVA.LANG.REFLECT.INACCESSIBLEOBJECTEXCEPTION                     
APAR SE69907  OSP-OTHER-INCORROUT ACS EHLLAPI SEND KEY (3) RETURNS INCORRECT 
RESPONSE WHEN CURSOR IS X INHIBITED.                              
APAR SE69916  OSP-UNPRED POSITIONING THE CURSOR USING MOUSE RESULT IN MESSAGE 
THE KEY USED TO EXIT FIELD NOT VALID                              
APAR SE69917  OSP-RC42601-MSGSQL01014 USING FRENCH LOCALE CAUSES MSGSQL01014 
IN SCHEMA SEARCH                                                  
APAR SE69947  OSP-INCORROUT ACS MIGHT HANG WHEN STARTING NEW 5250 TABBED 
SESSIONS                                                          
APAR SE69949  OSP-PAR-940XMISC STICKY POPUP KEYPAD DID NOT WORK CORRECT WITH 
TAB SETUP ACTIVATED IN A HOD EMULATION.                           
APAR SE69955  OSP-INCORROUT ACS DATA TRANSFER FILE CREATION INCORRECT CCSIDS 
FOR BLANK COLUMNS                                                 
APAR SE69983  OSP-UNPRED PRINT SCREEN SHOWS THICK BLACK VERTICAL LINES 
BENEATH FIELD DATA                                                
APAR SE69992  OSP-UNPRED INCORRECT CURSOR BEHAVIOR ON DISPLAY FILE WITH 
EDTWRD FUNCTION USING ARROW KEYS                                  
APAR SE70016  OSP-INCORROUT ACCESS CLIENT SOLUTIONS PRINTER SESSION SET TO 
USE JAVA PRINT SERVICE NOT PRINTING 198 COLUMNS                   
APAR SE70031  OSP-UNPRED SEVERAL INCORRECT CURSOR MOVEMENT ISSUES WITH DDS 
DISPLAY FILES                                                     
APAR SE70046  OSP-UNPRED  SEARCH PRESENTATION SPACE 6 RETURNS RC 24 IF 
PROGRAM SEARCH FOR DBCS BLANK                                             
APAR SE70047  OSP-UNPRED OK BUTTON DOES NOT WORK WHEN A DATA TRANSFER FILE IS 
PUT INTO THE DATA TRANSFER MIGRATION TOOL USING DRAG AND DROP     
APAR SE70048  OSP-INCORROUT EXTRA SPACE OR ZERO BEFORE NUMBER WHEN USING ACS 
DATA TRANSFER DOWNLOAD                                            
APAR SE70051  OSP-OTHER-INCORROUT CUSTOM DISPLAY LOGON CURSOR BLINKS PROPERLY 
IN CLIENT ACCESS, BUT NOT IN ACS.                                 
APAR SE70063  OSP-PAR-940XMISC JPS DBCS LPI; MARGINS AND START POSITION OF 
FIRST PRINTED LINE HAS OPTIONS AVAILABLE OR HAS BEEN FIXED.       
APAR SE70066  OSP ACS STARTING MULTIPLE SESSIONS IN BATCH NIGHT RESULT IN 
GETTING THE SAME SHORT SESSION ID                                 
APAR SE70106  OSP-INCORROUT ACS PROBLEMS WITH DDS PSHBTNCHC KEYWORD                                                                             
APAR SE70114  OSP-UNPRED DBCS CHARACTERS THAT SHOULD BE CORRECTED ARE 
REPLACED                                                                  
APAR SE70118  OSP ACS IFS DOWNLOAD WILL GET A MSGFI002 " THE FILE COULD NOT 
BE FOUND " WHEN THE FILE NAME CONTAINS AN ASTERISK                
APAR SE70142  OSP ACS DATA TRANSFER WILL GET A MSDB0036 SQL0206 WHEN USING 
FILENAME.FIELD SYNTAX IN THE JOIN CLAUSE                          
APAR SE70143  OSP ACS USING THE ATTN KEY AT A UNICODE FIELD MIGHT HANG THE 
SESSION                                                           
APAR SE70152  OSP-UNPRED CHARACTERS ARE SUBSTITUTED WHEN INPUT CHARACTER 
VALIDATION IS SET TO ON 
APAR SE70167  OSP-PAR-940XCOM IBM ACCESS CLIENT SOLUTIONS JAVA PRINT SERVICES 
MONOSPACE THA3270 FONT HAS COLUMN ALIGNMENT INCORRECT OUTPUT 
APAR SE70170  OSP-UNPRED DATA AFTER DBCS DATA IS NOT PASTED AFTER COPYING A 
STRING OF DATA FROM SEVERAL INPUT FIELD  
APAR SE70178  OSP-UNPRED MESSAGE ACS0020 REPORTED WHEN A SESSION IS CLOSED 
EVEN NOTHING HAS BEEN CHANGED IN FULL SCREEN MODE 
APAR SE70196  OSP-INCORROUT-ACCESS CLIENT SOLUTIONS ARABIC CHARACTERS 
PRINTING INCORRECTLY 
 
 



--------------------------------- 
Version = 1.1.8.0 
Build date = June 2018 
ESS Level = LCD8-2010-20 
 
Note: This version requires Java 8. To ensure uninterrupted usage, make sure 
your deployment is using Java 8 before deploying this version. 
      To check which version of Java is being used by IBM i Access Client 
Solutions, select Help->About from the product's main panel. 
 
Recommended Java Level: Java 8 Update 171 or higher 
--------------------------------- 
1. Enhancements to Database Schemas: 
   - Locked Rows (Table/Table Partition) 
   - Lock Holders (Alias/Index/Table/View) 
   - Table action to launch into View Journal Entries 
   - Change Schema Text 
   - Schema Properties 
   - SQL Package Properties 
   - Transactions  
   - Index and MQT partition lists 
   - Allow columns to be added before existing columns (RFE 109711) 
2. Enhancements to Run SQL Scripts: 
   - Add system name to title for result windows (RFE 104464) 
   - Added more examples to "Insert from Examples..." 
3. General DB Enhancements: 
   - Provide sortable columns for SQL Details for Jobs (RFE 114874) 
   - Add SQL Details for Jobs to the main SQL Performance Center dialog 
   - Preference to control the global naming convention (*SQL or *SYS) for DB 
tools. 
4. Enhancements to Data Transfer: 
   - Do not upload phonetic data from an xlsx file (RFE 106406)   
5. Enhancements to IFS: (RFE 117535, RFE 100792) 
   - Additional options for viewing and updating Properties and Permissions.  
6. Enhancements to 5250 Print: (RFE 95790, RFE 99537, RFE 107622) 
   - The 5250 print support has been significantly updated to enable Java 
Print Service (JPS) with the following features: 
     Characters per inch (CPI) 
     Lines per inch (LPI) for SBCS code page sessions (DBCS sessions always 
use 7.5 LPI) 
     Page size 
     Font size scaling (double-width, double-height, etc.) 
     SBCS and DBCS (with Shift Out and Shift In) text 
     Horizontal and vertical positioning 
     Grid lines 
     Barcodes 
     Font 
     Orientation (automatic, portrait, landscape) 
     With and without scaling (fit-to-page) 
   Note: ASCII transparency (data intended to go directly to the printer) is 
not supported 
7. Added Open Source Package Management: 
   A new interface for managing open source packages on the IBM i has been 
added to the Tools menu. 
8. Several fixes including: 
 



APAR SE68889  OSP-UNPRED ERRORLEVEL REPORTS 0 FOR DATA TRANSFER FROM AN EMPTY 
FILE                                                              
APAR SE68890  OSP-UNPRED J FIELD TYPE REPORT DOUBLE BYTE CHARACTER REQUIRED 
AS INPUT USING CURSOR KEYS                                        
APAR SE68897  OSP-WAIT ACS FREEZES ON MENU OPTION                                                                                               
APAR SE68905  OSP-ACCESS CLIENT SOLUTIONS DBCS HYPHEN SHIFTED ONE BYTE TO 
LEFT WHEN USING JAVA PRINT SERVICE                                
APAR SE68939  OSP-INCORROUT ACS FILE TRANSFER CREATE IBM I DATABASE FILE 
CREATES FILE WITH CCSID 1208                                      
APAR SE68962  OSP-INCORROUT CPF5192 - DATA SENT TO DEVICE NOT VALID. NEGATIVE 
RESPONSE CODE. DURING PROCESS OF RAPID SUCCESSIVE SCREEN UPDATES  
APAR SE68975  OSP-UNPRED COLOR CHANGES USING ARROW KEY SELECTING RECORDS ON 
DDS DISPLAY FILE                                                  
APAR SE68987  OSP-INCORROUT ACS HIGH RATE SCREEN REDRAW CAUSES DELAY FOR THE 
SCREEN UPDATES                                                    
APAR SE68998  OSP-UNPRED GRID LINES DDS GRDLIN DISAPPEAR WHEN A DDS GRDBOX IS 
BEING DISPLAYED                                                   
APAR SE68999  OSP-UNPRED 5250 SESSION WITH FIXED FONT DOES NOT DISPLAY A 
PHYSICAL CORRECTLY WHEN THE DATA EXCEEDS 80 CHARACTERS            
APAR SE69000  OSP-UNPRED SLASH FOR KEYWORD EDTMSK IN DDS DISAPPEARS WHEN TAB 
KEY IS BEING USED                                                 
APAR SE69021  OSP-UNPRED FLDCSRPRG HEADING TO THE J-FIELD USED IN DDS CAUSES 
INVALID CURSOR POSITION.                                          
APAR SE69033  OSP-UNPRED UNTRANSLATABLE CHARACTER SHOWN AS BLANK WITH HCP 939 
SET                                                               
APAR SE69048  OSP-INCORROUT SCREEN HISTORY ARCHIVE FILE NOT CREATED THOUGH 
SUCCESS MESSAGE DISPLAYED IF SESSION NAME CONTAINS INVALID CHAR   
APAR SE69053  OSP-INCORROUT ACS 5250 KEYBOARD IS NOT LOCKED DURING MACRO 
PLAYBACK.                                                         
APAR SE69074  OSP-INCORROUT ACS 5250 IN FULL SCREEN MODE WILL SHOW A LITTLE 
PANEL WHEN USING THE ALT AND KATAKANA KEY                         
APAR SE69078  OSP-DB-OTHER-MSGSQL0109 IACS LOOSING THE DEFAULT VALUE WHEN 
ADDING COLUMN TO EXISTING TABLE.                                  
APAR SE69101  OSP-INCORROUT ACS DATA TRANSFER ERROR MSGDB0036 STOPS THE 
TRANSFER                                                          
APAR SE69106  OSP-UNPRED MESSAGE ROLL UP OR DOWN PAST THE FIRST OR LAST 
RECORD IN FILE DOES NOT DISAPPEAR WHEN RESET KEY IS PRESSED       
APAR SE69110  OSP-UNPRED CREATING AN ADVISED INDEX FAILS WITH LANGUAGE DE_DE 
AND SORT SEQUENCE *NONE                                           
APAR SE69138  OSP-F/QLICUSRL-T/QZDANDB-MSGCPF2110 RUN SQL SCRIPTS SPECIFYING 
A LIBRARY LIST HAS NO AFFECT ON JOB. CPF2110 SEEN IN JOBLOG.      
APAR SE69211  OSP-UNPRED 5250 EMULATION MAXIMIZED ALWAYS ON PRIMARY DISPLAY 
IF DO NOT SHOW THE TITLE BAR WHEN MAXIMIZED IS SELECTED           
APAR SE69212  OSP-UNPRED IME KANJI INPUT IS INCORRECT                                                                                           
APAR SE69263  OSP-INCORROUT ACS 5250 EMULATION WILL NOT BE RESPONSIVE ANYMORE 
WHEN USING THE JUMP NEXT OR JUMP PREVIOUS FUNCTION                
APAR SE69273  OSP-INCORROUT-ACCESS CLIENT SOLUTIONS USING IBM5587.PDT                                                                           
APAR SE69314  OSP-INCORROUT ACS 5250 EMULATION WILL SHOW AN EXTRA GRAY BOX 
BEFORE CURSOR                                                     
APAR SE69317  OSP-UNPRED DATA TRANSFER REPORTS WARNING MESSAGE WHEN FILE 
EXTENSION DOES NOT MATCH THE FILE TYPE SPECIFIED                  
APAR SE69318  OSP ACS DATA TRANSFER MIGHT NOT RECOGNIZE THE RIGHT CURRENT 
SHEET                                                             
APAR SE69360  OSP-INCORROUT-ACS ACCESS CLIENT SOLUTIONS PRINTER SESSION 
MAXIMUM LINES PER PAGE NOT ALWAYS CORRECT USING IBM5577.PDT       
APAR SE69361  OSP-INCORROUT ACS SBCS KANA CHARACTER INPUT IN THE TYPE A FIELD                                                                   



APAR SE69400  OSP-UNPRED INPUT CHARACTER VALIDITY CHECK SET TO ON NOT WORKING 
CORRECTLY IN SPECIFIC ENVIRONMENT                                 
APAR SE69436  OSP-ACS-INCORROUT SPOOLED FILES JOINED AS ONE IN WINDOWS PRINT 
QUEUE WHEN PRINTING FROM ACS PRINTER SESSION USING IBM5577.PDT    
APAR SE69467  OSP-INCORROUT-ACCESS CLIENT SOLUTIONS BARCODE PRINTING 
INCORRECT USING BASIC_ASCII PDT IN ACS PRINTER SESSION 
APAR SE69499  OSP-PAR-940XCOM HOD POSITION IS NOT SAVED CORRECT WHEN WORKING 
WITH A SECOND DISPLAY 
APAR SE69503  OSP-UNPRED IME STATE INCORRECT SINCE VERSION 1173 CORRECT STATE 
SEEN WITH VERSION 1172 
APAR SE69508  OSP-UNPRED DATA FROM FIRST SCREEN STILL SHOWN ON POPUP SCREEN 
APAR SE69511  OSP-INCORROUT ALT+PAGEDOWN DOES NOT WORK CORRECTLY FOR SESSIONS 
STARTED BY PCSSTARTSESSION 
APAR SE69513  OSP-UNPRED LOCAL HOST LOOKUP USING VIRTUAL IP NOT FINDING 
CORRECT ADDRESS 
APAR SE69544  OSP-UNPRED NOT ABLE TO PASTE SINGLE AND DOUBLE QUOTE INTO J 
TYPE OR G TYPE FIELD 
APAR SE69547  OSP-INCORROUT FIELD+ KEY DOES NOT REMOVE THE MINUS (-) SIGN 
FROM A SIGNED NUMERIC FIELD IF THE FIELD CONTAINS THE MAXIMUM 
APAR SE69550  OSP-PAR-940XMISC POPUP KEYPAD SETTING FOCUS BACK TO TERMINAL 
DID NOT WORK CORRECT. 
 
--------------------------------- 
Version = 1.1.7.3 
Build date = February 2018 
ESS Level = LCD8-2010-19 
Recommended Java Level: Java 8 Update 161 or higher 
Note: The next update scheduled for June 2018 will require Java 8. 
--------------------------------- 
1. Enhancements to Database: 
   - More integration between Schemas and Run SQL Scripts (RFE 108105). 
   - Improved sorting for Show Statements in the SQL Performance Center. 
   - Dependency based sorting when generating SQL. 
   - Support for Properties, Start/End and Swap Receivers has been added to 
Journal. 
   - A legend has been added to Visual Explain. 
2. Enhancements to Data Transfer: 
   - Performance improvements when downloading large files especially to 
files of type txt, csv, dsr. 
3. Enhancements to IFS: 
   - Permissions action for displaying current authorities. 
   - View action for viewing the content of some objects. 
   - Updated icons and hover text for identifying symbolic links. 
4. Enhancements to 5250: 
   - Additional support for code page 1371 (Traditional Chinese). 
   - Copy Append As Table for copying a table from multiple pages. 
5. Enhancements to Printer Output. 
   - Download... action for allowing preferences to be temporarily overridden 
(RFE 115970). 
6. Several fixes including: 
 
APAR SE68339  OSP-UNPRED MSIME YEN SIGN INPUT RESULT IN A BACKSLASH 
APAR SE68340  OSP-UNPRED LOCK LEFT BEHIND ON FILES UPLOADED WITH ACS 
INTEGRATED FILE SYSTEM AND FOR FILES LISTED BY ACS IFS 
APAR SE68405  OSP-INCORROUT ACS DATA TRANSFER FROM EXCEL FAILS IF FIRST 
COLUMN NOT SELECTED 



APAR SE68411  OSP-DB-OTHER-MSGSQL0104 ACS SCHEMA, DATABASE MAINTENANCE -> 
INDEX REBUILDS, ERRORS WITH MSGSQL0104 BUT ONLY IF USING FRENCH 
APAR SE68431  OSP-INCORROUT ACS DATA TRANSFER UPLOAD FAILING WITH MSGDB0036 
WHEN TEXT FIELD ENDS WITH COMMA  
APAR SE68447  OSP-SLOW PRINTING OF *AFPDS SPOOLED FILE THROUGH ACCESS CLIENT 
SOLUTIONS 
APAR SE68451  OSP-UNPRED BACKSPACE NOT WORKING CORRECTLY ON A DSIPLAY FILE 
WITH CNTFLD KEYWORD FOR O TYPE FIELD 
APAR SE68452  OSP-UNPRED CHOICE MARKS NOT VISIBLE USING DDS KEYWORDS 
SNGCHCFLD MLTCHCFLD WITH DBCS TEXT 
APAR SE68499  OSP-UNPRED UPLOAD CSV FILE REPORTS MESSAGE THE DATA CANNOT BE 
SENT TO THE HOST FILE  
APAR SE68540  OSP-INCORROUT ACS MIGRATION OF JAPANESE DTF DATA TRANSFER 
REQUEST TO DTFX REQUEST RESULTS IN INCORRECT TARGET PATH 
APAR SE68565  OSP-INCORROUT ACS DDS CNTFLD KEYWORD O TYPE FILED, UPDATE WILL 
NOT WORK CORRECTLY 
APAR SE68576  OSP-INCORROUT ACS 5250 EMULATION , POP UP PANEL MIGHT CHANGE TO 
DBCS DEPENDING ON THE POSITION 
APAR SE68588  OSP ACS AND SELECTING SCHEMA-TABLE WILL SEE MSGACSDB0036 AND 
SQL0113 IN JOBLOG FOR DBCS SYSTEMS 
APAR SE68593  OSP-UNPRED SBCS CHARACTER INPUT WITH IME AUTO START SET BECOMES 
DBCS DATA 
APAR SE68608  OSP-UNPRED REPLACEMENT CHARACTER CREATED BY DUP KEY IS SENT 
WHEN INPUT CHARACTER VALIDATION IS SET TO ON 
APAR SE68664  OSP-INCORROUT NLS TURKISH CHARACTERS PROBLEMS ON ACS DATA 
TRANSFER POPUP WINDOW 
APAR SE68670  OSP-INCORROUT ACS TYPE W FIELD SBCS KANA CHARACTER INPUT 
PROBLEMS 
APAR SE68692  OSP-INCORROUT ACS SBCS KANA CHARACTER INPUT IN THE TYPE O FIELD 
PROBLEMS 
APAR SE68729  OSP-UNPRED HMC 5250 CONSOLE LOCKS INDEFINITELY AFTER TIME OUT 
APAR SE68731  UNPRED-HLIC-94XXCOM ACS HANG WHEN WORKING WITH SYSTEM 
CONFIGURATION / ADVANCED HMC 5250 OPTIONS 
APAR SE68733  OSP-INCORROUT JAPANESE POSTAL BAR CODE DOES NOT PRINT CORRECTLY 
ON IBM PAGES PRINTER WHEN USING ACCESS CLIENT SOLUTIONS 
APAR SE68756  OSP-UNPRED URL HOTSPOT FAILS IF FILE NAME HAS SPACES 
APAR SE68761  OSP-UNPRED ACS 5250 EXTRA POPUP PANEL IS PRESENTED AFTER 
ENTERING ALT FX WHICH PASTED A TEXT INTO THE SESSION 
APAR SE68767  OSP-UNPRED CURSOR IS NOT A DBCS CURSOR IF KEYWORD SNGCHCFLD IS 
WITHIN DDS 
APAR SE68792  OSP-UNPRED CHARACTER MISSING AND CHANGED COLOR DISPLAYING 
SUBFILE 
APAR SE68802  OSP-INCORROUT ACS 5250 EMULATION WILL NOT SHOW ALL WINDOW 
CORRECTLY 
APAR SE68811  OSP IN ACCESS CLIENT SOLUTIONS VERSION 1.1.7.2 HOTSPOTS TO URLS 
HAVE STOPPED WORKING 
APAR SE68825  OSP-INCORROUT ACS 5250 EMULATION MIGHT NOT SHOW FX KEY, CORNER 
OF THE WINDOW FRAME 
APAR SE68830  OSP-INCORROUT ACS TRANSFER DATABASE FILE CREATED WITH INCORRECT 
CCSIDS 
APAR SE68867  OSP-UNPRED PRESS ANY KEY TO RETURN WITH STRPCCMD NOT RETURNED 
WITH LOCALE SET TO JA_JP 
 
--------------------------------- 
Version = 1.1.7.2 
Build date = October 2017 
ESS Level = LCD8-2010-18 



Recommended Java Level: Java 8 Update 144 or higher 
Note: The next update scheduled for February 2018 will require Java 8. 
--------------------------------- 
1. General enhancements: 
   - Added SSH Terminal (when an already installed SSH client is found like 
cygwin, PuTTY, bash, Terminal, Xterm, etc) (RFE 95109) 
   - LAN Console Keep Alive (RFE 99856) 
2. Enhancements to Printer Output: 
   - Date/Time format based on locale (RFE 108708) 
3. Enhancements to Data Transfer: 
   - Added option to exclude line endings (RFE 110105) 
4. Enhancements to Schemas: 
   - Added Database Maintenance options for Check Pending Constraints, Index 
Builds, Index Rebuilds, Table Alters, Table Reorganizations 
   - Added Database Maintenance option for Text Index Builds (when OmniFind 
Text Search Server is installed) 
   - Added Related Objects to Views, "Work with" 
   - Added more optional columns to Tables 
5. Enhancements to Run SQL Scripts: 
   - Added Change Query Attributes for Connection 
   - "Save as..." location defaults to script location (RFE 94390) 
   - SQL formatting like legacy Client Access (RFE 103029) 
   - Added ability to customize border under View (RFE 108149) 
   - Added examples to "Insert from Examples..." for new IBM i Services 
6. Several fixes including: 
 
APAR SE67730  OSP-UNPRED UNABLE TO RESTRICT "SCHEMAS" WITHIN THE GROUP 
"DATABASE" 
APAR SE67748  OSP-INCORROUT-PRT ASCII TRANSPARENCY IS NOT WORKING FOR DBCS 
SPOOL DATA 
APAR SE67769  OSP-UNPRED ACS SESSION WITH 27X132 FREEZES WHEN QUERYING PF 
APAR SE67792  OSP-UNPRED ACS SHOW SQL STATEMENTS REFRESH DOES NOT KEEP SORT 
APAR SE67796  OSP-F/QWSGET-T/QWSGET-MSGCPF5411 OVERLAPPING FIELDS IN DSPF 
LEAD TO MSGCPF5411 
APAR SE67811  OSP-INCORROUT ACS WILL NOT HANDLE FPNN HOTPSOT CORRECTLY 
APAR SE67868  OSP-INCORROUT COPY AND PASTE FUNCTION NO LONGER WORKING ORDER 
ENTRY FIELDS 
APAR SE67892  OSP-INCORROUT IBM I ACS ALT KEYBOARD MAPPING PROBLEMS 
APAR SE67957  OSP-INCORROUT ACS 5250 SCREEN BACKGROUND COLOR WILL SET WHEN 
UNICODE IS ENABLED 
APAR SE67962  SAVE OF VISUAL EXPLAIN WITH LARGE NUMBER OF PLAN NODES CAUSING 
ACS TO HANG 
APAR SE67972  OSP-INCORROUT ACS SQL PERFORMANCE CENTER, DB FUNCTION 
TRANSLATION FOR OTHER LANGUAGES IS MISSING 
APAR SE67984  OSP-INCORROUT ACS PROBLEMS WITH DDS MENUBAR BORDER COLOURS 
APAR SE67996  OSP-INCORROUT UNABLE TO CONNECT VIA RUN SQL SCRIPT USING 
ASENSITIVE 
APAR SE68003  OSP-INCORROUT-PRT PDT PRINTING 
APAR SE68027  OSP-PAR-940XMISC WHEN A SPOOLED FILE IS OUTPUT BY ACS117 WITH 
NON-IBM FUJIXEROXPRINTER.PDT, THE FIRST COLUMN RECORDS "BBB" 
APAR SE68037  OSP-WAIT RUN SQL SCRIPTS CLOSING AN EXISTING RESULT WINDOW 
WHILE ANOTHER LONG RUNNING QUERY IS ACTIVE WILL BOCK OTHER ACS 
APAR SE68048  OSP-INCORROUT RUN SQL SCRIPTS RUN TIME MESSAGE SHOW INCORRECT 
TIME VALUES 
APAR SE68061  OSP-UNPRED INCORRECT SCREEN AFTER RETURNING FROM ATTENTION 
PROGRAM 



APAR SE68080  OSP-UNPRED ACS EHLLAPI @A@U (ROLLUP), @A@V (ROLLDOWN) DOES NOT 
WORK 
APAR SE68092  OSP-INCORROUT RIGHT CLICK FROM SPECIFIED FIELD WITH BUILT IN 
MENU DOES NOT OPEN THE MENU CORRECTLY 
APAR SE68098  OSP-UNPRED SHIFT-TAB DOES NOT WORK CORRECTLY, ON SCREEN WITH A 
MULTIPLE SELECTION FIELD 
APAR SE68135  OSP-INCORROUT ACS 1.1.7.1 DATA TRANSFER WITH ACTIVE EXCEL 
SPREADSHEET REQUESTING SAVE 
APAR SE68152  OSP-INCORROUT IBM I ACCESS CLIENT SOLUTIONS PRINTER EMULATION 
SESSION NOT PROMPTING AS EXPECTED 
APAR SE68171  OSP-OTHER-INCORROUT ACS DATA TRANSFER FAILS TO CREATE 
ADDITIONAL SHEETS IN .XLS AND .XLSX FILES 
APAR SE68172  OSP-UNPRED MESSAGE "DATA CAN NOT BE SENT TO THE HOST FILE" 
RECEIVED FOR UPLOADING A FILE WITH BLANKS IN COLUMN 
APAR SE68185  OSP-INCORROUT ACS UPLOAD FILE WITH EOF X'1A' RESULTS ON 
ADDITIONAL RECORD 
APAR SE68193  OSP ACS USING FIELD EXIT AT J TYPE INPUT FIELD WILL REMOVE 
SHIFT OUT CODE 0E 
APAR SE68199  INCORROUT-CRT-D/T5251-HLIC COLOR SETTINGS ARE NOT CORRECTLY 
SAVED IN THE HOD PREFERENCES 
APAR SE68229  OSP-UNPRED LOGON DIALOG ON MAIN DISPLAY WHEN SESSION IS ON 
EXTERNAL DISPLAY IN A MULTIPLE DISPLAY ENVIRONMENT 
APAR SE68236  OSP-INCORROUT IBM I ACCESS CLIENT SOLUTIONS DISPLAY DESCRIPTION 
PANEL NOT FOLLOWING IMPORTED SETTING ON FIRST LAUNCH 
APAR SE68294  INCORROUT BARCODE IS INCORRECTLY PRINTED AFTER MIGRATING THE 
EMULATOR FROM IAW TO ACS                                     
 
--------------------------------- 
Version = 1.1.7.1 
Build date = July 2017 
ESS Level = LCD8-2010-17 
Recommended Java Level: Java 8 Update 144 or higher 
--------------------------------- 
1. General enhancements: 
   - Option to disable end users from accepting "trusted" signers (RFE 99153) 
   - Option to enable SSL by default (RFE 100725) 
   - Enable "Check for updates" from command line (RFE 96516) 
   - Provide better error details (RFE 99599, RFE 105977) 
2. Enhancements to 5250 Emulation: 
   - Screen History Archiving 
   - Toolbar buttons for launching Navigator for i (RFE 100673), Schemas (RFE 
106817), and SQL Performance Center (RFE 106817) 
3. Enhancements to Printer Output: 
   - Combine date/time into single column with most current entry displayed 
first (RFE 93655) 
   - Date/Time filter (RFE 99212) 
   - Filter Reset button (RFE 104310) 
4. Enhancements to Data Transfer: 
   -  Automatically truncate extra columns during upload (RFE 106407) 
5. Enhancements to Schemas: 
   - Added Health Center 
   - Additional filters for object folders 
   - Action for checking permissions 
   - Added View Entries to Journals 
6. Enhancements to Run SQL Scripts: 
   - Added SQL Performance Monitor 
   - Added headings to text type output (RFE 91120) 



7. Enhancements to SQL Performance Center: 
   - Added Import SQL performance data 
   - Support for adding new SQL Performance Monitors, Plan Cache Snapshots, 
and SQL Plan Cache Event Monitors 
   - Properties dialog for SQL Performance Monitors, Plan Cache Snapshots, 
and SQL Plan Cache Event Monitors 
8. Enhancements to Visual Explain: 
   - Added icon Help text 
9. Several fixes including: 
 
APAR SE67026  OSP-UNPRED MACOS NSINVALIDARGUMENTEXCEPTION POP-UP WINDOW 
APPEAR WHEN FRONT-END PROCESSING IS TURNED ON                      
APAR SE67044  OSP-UNPRED ACS V1R1M7 117 HEADLESS=TRUE CRASHES BINARY                                                                             
APAR SE67056  OSP-UNPRED DATA TRANSFER UPLOAD CSV FILE REMOVED LEADING BLANKS 
FOR NUMERIC RECORD                                                 
APAR SE67076  OSP-INCORROUT UNABLE TO MAP THE BACKTAB FUNCTION TO 
CONTROL(LEFT)+TAB.                                                 
APAR SE67086  OSP-UNPRED ACS DATA TRANSFER UPLOAD TAB DELIMITED TEXT FILE 
REMOVED LEADING BLANKS FOR NUMERIC RECORD                          
APAR SE67088  OSP-UNPRED RUNNING ACS DATA TRANSFER FROM CMD PROMPT DISPLAY 
THE GUI DIALOG "DO YOU WANT TO SAVE THIS TRANSFER REQUEST?"        
APAR SE67097  OSP-INCORROUT ACS CHARACTER BACKSPACE HOST FUNCTION MOVES 
CURSOR TO INCORRECT POSITION                                       
APAR SE67103  OSP-INCORROUT- GRID LINE NOT PRINTED ON HOST PRINT SCREEN 
THROUGH ACCESS CLIENT SOLUTIONS DISPLAY SESSION                    
APAR SE67108  OSP-INCORROUT IBM I ACS EHLLAPI HANDLES SOME RETURN CODES 
WRONG, APPLICATIONS MAY NOT GET DATA EXPECTED FROM SESSION.        
APAR SE67119  OSP-UNPRED MSGSY1008 WHEN CHANGING PASSWORD WHICH BEGINS WITH A 
DIGIT (QPWDLVL 0 OR 1)                                             
APAR SE67122  OSP-UNPRED MOUSE POINTER IS AN ARROW WHEN HOVERING OVER AN URL 
HOTSPOT WHEN A WATERMARK IS IN USE                                 
APAR SE67147  OSP-UNPRED MODIFIED DATE AND TIME ARE CHANGED OF XLSX PC FILE 
DOING ACS DATA TRANSFER UPLOAD                                     
APAR SE67151  OSP-UNPRED RETURNING TO 5250 SESSION, OVERLAYS ARE NOT 
DISPLAYED AFTER CLICKING URL HOT SPOT                              
APAR SE67172  OSP-UNPRED LOSING CURSOR ON THE PROMPT SCREEN FROM A PROGRAM                                                                       
APAR SE67176  OSP-PERFM ACCESS CLIENT SOLUTIONS HANGS WHEN TRYING TO PRINT A 
PRINT COLLECTION.                                                  
APAR SE67193  OSP-UNPRED GRID LINES ARE INCORRECTLY PAINTED ON THE SCREEN IN 
COMPARISON WITH PCOM.                                              
APAR SE67205  OSP-INCORROUT ACS DB CREATION WIZARD WILL CHOOSE WRONG FIELD 
SIZE                                                               
APAR SE67214  OSP-INCORROUT ACS DB CREATION WIZARD WILL FAIL IF FIRST LINE OF 
AN EXCEL SHEET DOESN'T CONTAIN THE FIELD NAMES MSGGEB005           
APAR SE67239  OSP-UNPRED UNABLE TO RE-TYPE UPPER/LOWER LEVEL OF THAI 
CHARACTER                                                                   
APAR SE67240  OSP-UNPRED COPY THAI CHARACTER TO NOTEPAD TRUNCATED IF ONLY 
THAI CHARACTER IS SELECTED                                         
APAR SE67335  OSP-INCORROUT NUMERIC DATA IN ROW, COLUMN HAS TOO MANY DIGITS 
FOR THE IBM I ERROR MESSAGE RECEIVED WHEN UPLOADING AN XLS FILE    
APAR SE67349  OSP-THREADS-INCORROUT ACS EXCEL DATA TRANSFER FROM OPEN SHEET 
MIGHT CRASH THE DATA TRANSFER APPLICATION                          
APAR SE67367  OSP-INCORROUT ACS SCREEN HISTORY ARCHIVE WILL FAIL AFTER 
DEPLOYMENT FROM ACS_BAK                                            
APAR SE67383  OSP-INCORROUT DISPLAY FILE WITH GRID LINE HAS MISSING PART ON 
ROW 1 COLUMN 1 WHEN USING ACS                                      



APAR SE67406  OSP-INCORROUT ACS PROVIDING INCORRECT PASTE OUTPUT WHEN PASTING 
INTO FIELD CONTAINING "/"S                                         
APAR SE67416  OSP-UNPRED UPLOAD FAILS WHEN HOST FILE WITH PACK DECIMAL 
COLUMNS                                                                   
APAR SE67477  OSP-INCORROUT-ACCESS CLIENT SOLUTIONS IGNORING SHIFT IN ( X'0F 
) WHEN PRINTED THROUGH PRINTER SESSION                             
APAR SE67478  OSP-INCORROUT ACS INCORRECTLY SKIPPING PROTECTED FIELDS WHEN 
PASTING.                                                           
APAR SE67498  OSP-UNPRED DECIMAL VALUES INCORRECT IN TARGET FILE UPLOADING 
EXCEL FILE                                                         
APAR SE67511  OSP-INCORROUT ACS EHLLAPI FIND FIELD (32) FUNCTION RETURNS 0, 
INCORRECT VALUE.                                                   
APAR SE67527  OSP-UNPRED UPLOADING TAB DELIMITED TEXT FILE TO SOURCE PHYSICAL 
FILE DOES NOT WORK                                                 
APAR SE67573  OSP-INCORROUT INCORRECT FORMAT WHEN UPLOADING TAB DELIMITED 
TEXT FILE TO SOURCE PHYSICAL FILE                                  
APAR SE67580  OSP-UNPRED CURSOR MOVES TO WRONG POSITION ON A DISPLAY FILE 
WITH CONFIGURED BUTTONS                                            
APAR SE67588  OSP-INCORROUT ACS EMULATOR IS NOT BEHAVING CORRECTLY WITH 
CUSTOM MADE SCREENS.                                               
APAR SE67590  OSP-INCORROUT DBCS SESSION WITH AUTOMATIC RESIZE SET SHOWS PART 
OF PREVIOUS SCREEN                                                 
APAR SE67591  OSP-UNPRED PRINT SCREEN (LOCAL COPY) IS NOT INCLUDED IN A MACRO 
WHEN RECORDED.                                                     
APAR SE67632  OSP-INCORROUT DATA IS DROPPED WHEN SQL STATEMENT IS COPIED FROM 
MULTIPLE CELLS (EXCEL) AND PASTE ON ACS 5250 ON MAC                
APAR SE67640  OSP-INCORROUT ACS BATCH PROCESSING, WINDOWS ERRORLEVEL NOT 
WORKING, ONLY 0 WILL BE RETURNED                                   
APAR SE67643  OSP-UNPRED CRED. CACHE NOT USED WHEN HOD FILE HAS SET "USE 
DEFAULT USER NAME ..." AND SYSTEM CONFIG HAS "PROMPT EVERY TIME"   
APAR SE67649  OSP-INCORROUT ACS 5250 EMULATION WILL SOMETIMES STILL SHOW THE 
BORDER OF A PREVIOUS SCREEN                                        
APAR SE67669  OSP-INCORROUT EURO SIGN NOT SHOWN IN FONT IBM3270-1251                                                                             
APAR SE67670  OSP-UNPRED MINUS SIGN FOR NUMBER NOT PASTE                                                                                         
APAR SE67698  OSP-ACCESS CLIENT SOLUTIONS-GRID LINES NOT PRINTING CORRECTLY 
ON PRINT SCREEN COLLECTION 
APAR SE67739  OSP-UNPRED PASTING, COPY OF TABLE, DATA INTO EXCEL ADDS A BLANK 
LINE TO THE LAST LINE 
APAR SE67744  OSP-INCORROUT ACS UPLOAD OF NEGATIVE CURRENCY VALUES FROM EXCEL 
FAILS 
APAR SE67755  OSP INCORROUT-ACCESS CLIENT SOLUTIONS-SPOOLED FILE GENERATED BY 
APW WITH BAR CODE PRINTS INCORRECTLY 
APAR SE67764  OSP OSP-UNPRED HOTSPOTS NOT WORKING WHEN HOST CODE PAGE IS SET 
TO 838                                                                                                                                                                        
 
 
--------------------------------- 
Version = 1.1.7.0 
Build date = March 2017 
ESS Level = LCD8-2010-16 
--------------------------------- 
The following features have been added: 
1. Initial release of Schemas – Database management interface 
   Supported object actions include: 
   -Manage definitions 
   -Manage descriptions 
   -Generate SQL  



   -Work with properties 
   -Object rename 
   -Create new database object 
   -Show object references  
   -Index advisor  (raw and condensed) 
   -Explain SQL 
   -Table data actions (view, clear, copy, initialize) 
   -Integrates with Visual Explain  
   -Integrates with SQL Plan Cache 
   -Much more 
2. Enhancements to Run SQL Scripts  
   - Added CL Prompter  
   - Added upload results 
   - Improved formatting  
   - Enhanced SQL highlighting  
   - Many new 'Insert from Examples' (built using SQL Services) 
3. Several fixes including: 
 
APAR SE66556  OSP-UNPRED CURSOR POSITIONING ISSUES JUMPING FROM INPUT FIELDS 
IN DBCS ENVIRONMENT 
APAR SE66557  OSP-UNPRED CURSOR MOVES IN PROTECTED FIELD USING ARROW KEYS,IT 
DOES NOT JUMP TO THE NEXT AVAILABLE ENTRY FIELD 
APAR SE66572  OSP-UNPRED MSGFI002 UNABLE TO FIND FDFX FILE ON ACS DATA 
TRANSFER UPLOAD WHEN SAVED DTTX AND FDFX FILE NAMES ARE 
APAR SE66577  OSP-INCORROUT ACS EMULATION CURSOR MOVES INCORRECTLY TO 
PROTECTED FIELD 
APAR SE66595  OSP RUN SQL SCRIPTS - KEYBOARD KEY: END QUIT GOING TO THE END 
OF THE LINE, AND WENT TO THE START OF THE NEW LINE 
APAR SE66633  OSP-INCORROUT ACS DATA TRANSFER MAY ALLOW UNINTENTIONAL JOIN OF 
A FILE MEMBER TO ITSELF 
APAR SE66647  OSP-INCORROUT ACS PRINTER EMULATION OUTPUT, RIGHT BOARDER COULD 
NOT BE MINIMIZED 
APAR SE66667  OSP-UNPRED THAI SESSION IN ENGLISH MODE SOME KEYS STILL TYPE 
THAI CHARACTERS 
APAR SE66686  OSP-MSGSQL0104 ACS RUN SQL SCRIPT FAILS WITH SQL0104 WHEN 
SEVERAL STATEMENTS WITH CASE(SUBSTR ARE RUN 
APAR SE66700  OSP-UNPRED CLIENTFILE AND HOSTFILE EMPTY NOF FILLED IN DATA 
TRANSFER REQUEST FILE 
APAR SE66703  OSP-INCORROUT SSL DATA TRANSFER CONNECTION REQUIRES MULTIPLE 
PROMPTS FOR CREDENTIALS 
APAR SE66803  OSP-WAIT BYPASS SIGNON NOT WORKING 
APAR SE66826  OSP-INCORROUT ACCESS CLIENT SOLUTIONS DATA TRANSFER UPLOAD 
FAILS ON CURRENCY FIELD 
APAR SE66867  OSP-UNPRED CURSOR POSITIONING ISSUE USING ARROW KEYS 
APAR SE66875  OSP-UNPRED NEW SPECIFIED OUTPUT FILE IN SAVED DATA TRANSFER NOT 
USED WHEN <ENTER> USED 
APAR SE66882  OSP-INCORROUT ACCESS CLIENT SOLUTIONS FAILING TO SHOW CORRECT 
SQL QUERY OUTPUT OF AN ENCRYPTED FIELD 
APAR SE66894  OSP-INCORROUT ACCESS CLIENT SOLUTIONS BAR CODE NOT PRINTING 
CORRECTLY FOR JAPANESE SPOOLED FILE 
APAR SE66929  OSP-THREADS-UNPRED RUNNING QUERY, THE QUERY STATUS IN LINE 24 
OF 5250 IS NOT DISPLAYED 
APAR SE66981  OSP/PLUGIN=CERTDL ONLY DOWNLOADS THE LOCAL CERTIFICATE 
AUTHORITY ON THE SYSTEM 
APAR SE66997  OSP-UNPRED ENTER SBCS CHARACTER, SHIFT-IN AND SHIFT-OUT 
REPLACES TWO DBCS CHARACTERS  



APAR SE67007  OSP-INCORROUT EMULATOR LAUNCHED DATA TRANSFER FAILS WITH 
MSGFI002 THE SYSTEM CANNOT FIND THE PATH SPECIFIED 
APAR SE67061  OSP-INCORROUT ACS SCRATCH PAD DOES NOT BEHAVE CORRECTLY WITH 
TABS ENABLED.                                                      
 
 
--------------------------------- 
Service Pack Level = LCD8-2010-15 
Build date = January 2017 
--------------------------------- 
The following features have been added: 
1. Enhanced Printer Output filter to support multiple output queues and User-
Specified Data. 
2. Enhanced Data Transfer to support Dos Random. 
3. Enhancements to restrict functions using Application Administration. 
4. A bridge for running EHLLAPI with 5250 applications is available on the 
Update web site. 
5. Several fixes including: 
 
APAR SE62680  OSP-INCORROUT ACS 114 HLLLENGTH IS NOT UPDATED                                                                             
APAR SE66061  OSP-INCORROUT ACCESS CLIENT SOLUTIONS GRID LINE PRINTS 
INCORRECTLY ON XEROX IN ESCP MODE WITH CUSTOMIZED PDT FILE 
APAR SE66062  OSP-INCORROUT ACCESS CLIENT SOLUTIONS DATA WRAPPING TO SECOND 
LINE WHEN PRINTED ON XEROX IN ESCP MODE USING CUSTOM PDT FILE 
APAR SE66121  OSP-INCORROUT ACS SOME CHARACTERS WILL NOT BE SHOWN WHEN USING 
HOST CODE PAGE 1112 IN THE EMULATION SETUP AND IBM3270 1257 FONT 
APAR SE66129  OSP-INCORROUT ACS USING MLTCHCFLD DDS KEYWORD, A DESELECTION OF 
AN OPTION VIA A MOUSE CLICK WILL NOT WORK.                 
APAR SE66158  OSP-INCORROUT ACS NUMERIC 8,0 DATA WILL BE SHOWN IN AN EXCEL 
SHEET IN AN EXPONENTIAL NOTATION                           
APAR SE66174  OSP-INCORROUT-ACCESS CLIENT SOLUTIONS CHARACTER SPACING AND 
VERTICAL LINES INCORRECT WHEN USING ESC_P.PDF              
APAR SE66200  OSP-UNPRED KEYBOARD FILE LOCATION (KEYREMAPFILE) NOT WRITTEN 
WITH FULL PATH.                                            
APAR SE66201  OSP-UNPRED YEN SIGN IS CLEARED WHEN IT IS ENTERED ON A W TYPE 
FIELD WITH IME AUTO START ON                               
APAR SE66247  OSP-INCORROUT DISPLAY FILE WITH DDS WINDOW BORDER HAS SOME ROWS 
THAT ARE LEFT WITH SAME COLOR AS TEXT ROW                  
APAR SE66249  OSP-UNPRED HIGH RESOLUTION SCREENS, FONT RENDERING IS POOR.                                                                
APAR SE66253  OSP-INCORROUT DOTTED / DASHED LINE WRAPPING WHEN PRINTING 
THROUGH ACCESS CLIENT SOLUTIONS PRINTER SESSION TO XEROX   
APAR SE66254  OSP-INCORROUT PRINT LINES WRAPPING WHEN PRINTING THROUGH ACCESS 
CLIENT SOLUTIONS PRINTER SESSION TO XEROX PRINTER          
APAR SE66255  OSP-INCORROUT LINES PER INCH DIFFERENT WHEN PRINTING THROUGH 
ACCESS CLIENT SOLUTIONS PRINTER SESSION TO XEROX PRINTER   
APAR SE66261  OSP-INCORROUT .PMP FILE TYPES NOT GETTING SAVED IN THE EXPORT 
CONFIGURATION                                              
APAR SE66271  OSP-INCORROUT STRPCCMD FAILS WITH NOT RECOGNIZED AS AN INTERNAL 
OR EXTERNAL COMMAND, OPERABLE PROGRAM OR BATCH FILE        
APAR SE66281  OSP-UNPRED GRID LINE DOES NOT DISAPPEAR WHEN GOING TO THE NEXT 
SCREEN                                                     
APAR SE66299  OSP-INCORROUT 8 LPI NOT PRINTING CORRECTLY THROUGH ACCESS 
CLIENT SOLUTIONS PRINTER SESSION                           
APAR SE66315  OSP-UNPRED PASSWORD NOT CACHED USING A BATCH FILE WITH 
/PLUGIN=LOGON                                              
APAR SE66340  OSP-MSGCPF2110 ACS FILE TRANSFER INCORRECTLY ADDS IASP NAME TO 
LIBRARY LIST.                                              



APAR SE66385  OSP-INCORROUT JAPANESE SPECIAL CHARACTER NOT PRINTED THROUGH 
ACCESS CLIENT SOLUTIONS PRINTER SESSION                    
APAR SE66414  OSP-INCORROUT ACCESS CLIENT SOLUTIONS DOWNLOAD PRINTER OUTPUT 
OF*LINE SPOOLED FILE INCORRECT                               
APAR SE66415  OSP-INCORROUT ACCESS CLIENT SOLUTIONS NOT ALL PAGES OF SPOOLED 
FILE PRINTS TO XEROX PRINTER USING CUSTOM PDT FILE         
APAR SE66416  OSP-INCORROUT ACCESS CLIENT SOLUTIONS POSITIONS OF CHARACTERS 
INCORRECT PRINTING TO XEROX WITH CUSTOMIZED PDT            
APAR SE66468  OSP-UNPRED PARAMETER *SHARE FOR /USERID FOR CFG PLUGIN DOES NOT 
WORK                                                       
APAR SE66469  OSP-INCORROUT MSGGEN005 ILLEGAL HEXADECIMAL CHARACTER N AT 
INDEX N WHEN USING ACS VISUAL EXPLAIN ON STORED PROCEDURE. 
APAR SE66482  OSP-UNPRED LEFT ARROW KEY WILL NOT SKIP TO PREVIOUS INPUT FIELD                                                            
APAR SE66483  OSP-UNPRED CURSOR POSITIONING NOT WORKING CORRECTLY USING THE 
UP ARROW KEY                                               
APAR SE66504  OSP-INCORROUT DOWN ARROW KEY WILL NOT SKIP TO CORRECT POSITION 
ON NEXT INPUT FIELD                                        
APAR SE66526  OSP-INCORROUT-ACS PRINTER OUTPUT DOWNLOAD IN TEXT FORMAT 
IGNORES PAGE RANGE 
 
 
--------------------------------- 
Service Pack Level = LCD8-2010-14 
Build date = October 2016 
--------------------------------- 
The following features have been added: 
1. Added Integrated File System (IFS) action and icon for newly defined 5250 
emulation sessions. 
2. Added hover text revealing file description when browsing files within 
Data Transfer.  
3. Several fixes including: 
 
APAR SE65439  OSP-INCORROUT APW SYMBOL NOT PRINTED THROUGH ACCESS CLIENT 
SOLUTIONS PRINTER SESSION 
APAR SE65475  OSP-INCORROUT TEXT POSITION DIFFERENT USING ACS PRINTER SESSION 
WITH JAVA PRINT SERVICES 
APAR SE65488  OSP-MSGSQL5016 USING RUN SQL SCRIPTS WITH *SYS SYSTEM NAMING 
CONVENTION MSGSQL5016 IS RETURNED 
APAR SE65498  OSP-INCORROUT ACS WIDTH OF GRID LINES INCORRECT WHEN PRINTING 
THROUGH ACCESS CLIENT SOLUTIONS PRINTER SESSION 
APAR SE65513  OSP-INCORROUT ACS DATA TRANSFER DB CREATION WIZARD WILL HANG 
FOR SHEETS WITH MORE THAN 8999 CELLS 
APAR SE65517  TIME OF DAY AND CREATION DATE ARE INCORRECT AFTER APPLYING THE 
1.1.6.0 BUILD 6320 DATED AUGUST 1, 2016. 
APAR SE65518  OSP-INCORROUT ACS FILE TRANSFER DOWNLOAD PACKET FIELDS ARE 
PADDED WITH SPACES EVEN IF PAD WITH LEADING ZEROS IS SPECIFIED 
APAR SE65525  OSP-INCORROUT ACS DATA TRANSFER NOT REMOVING SPACES FROM 
CHARACTER NUMERIC VALUES 
APAR SE65541  OSP-INCORROUT ACCESS CLIENT SOLUTIONS PRINTER SESSION PRINTS 
AMIKAKE ( SHADING ) INCORRECTLY 
APAR SE65542  OSP-INCORROUT ACCESS CLIENT SOLUTIONS 1 MM GAP IN AMIKAKE 
(SHADING) AFTER TEST FIX 
APAR SE65543  OSP-INCORROUT ACCESS CLIENT SOLUTIONS APW DOUBLE MAGNIFIED GRID 
LINES NOT PRINTING 
APAR SE65549  OSP-INCORROUT KEYBOARD FAST UP AND FAST DOWN FUNCTIONS MISSING 
APAR SE65565  OSP-INCORROUT DATA TRANSFER FROM IBM I WHERE CLAUSE DOESN'T 
ALLOW TO SPECIFY A VALUE ON COMPARE POPUP SCREEN 



APAR SE65567  OSP-INCORROUT-ACESSS CLIENT SOLUTIONS ( ACS ) CHARACTERS 
SHIFTED RIGHT IN PRINTED OUTPUT 
APAR SE65568  OSP-INCORROUT-ACCESS CLIENT SOLUTIONS ( ACS ) BLANK PAGE ADDED 
IN PRINTER OUTPUT 
APAR SE65569  OSP-INCORROUT-ACCESS CLIENT SOLUTIONS ( ACS ) UNEXPECTED EQUAL 
SIGN (MARK) PRINTED THROUGH ACS PRINTER SESSION 
APAR SE65571  OSP-INCORROUT-ACCESS CLIENT SOLUTIONS ( ACS ) APW MAGNIFY DOES 
NOT WORK 
APAR SE65573  IBM I ACCESS CLIENT SOLUTIONS PRINTER OUTPUT LOOSES COLUMN 
SORTING CRITERIA AFTER AN ACTION SUCH AS DELETE. 
APAR SE65575  OSP-INCORROUT ACS DATA TRANSFER FROM SYSTEM I INTO A XLSX WILL 
DELETE LEADING SPACES / BLANKS 
APAR SE65576  OSP-INCORROUT-ACCESS CLIENT SOLUTIONS PRINTED OUTPUT STARTING 
LOWER ON THE PAGE 
APAR SE65578  OSP-INCORROUT-ACCESS CLIENT SOLUTIONS PRINTER SESSION NOT 
PRINTING APW GRID LINES 
APAR SE65606  OSP-UNPRED MIGRATION OF TOOL BAR FILE DESTROYS JAPANESE 
CHARACTERS 
APAR SE65640  OSP-INCORROUT ACS DISPLAY SESSION USING CP 1112 WILL NOT SHOW 
ALL CHARACTERS. 
APAR SE65641  OSP-INCORROUT IBM I ACS WINDOWS_APPLICATION SINGLE USER INSTALL 
SCRIPT DOES NOT INSTALL TO /USERS/USER_ID/IBM/CLIENT SOLUTIONS 
APAR SE65649  OSP-INCORROUT ACS GRID LINE CLEAR WILL NOT CLEAR ALL GRID LINES 
APAR SE65652  OSP-UNPRED IBM I ACCESS CLIENT SOLUTIONS CRASHES ON OPEN USING 
ACSLAUNCH_32.EXE OR ACSLAUNCH_64.EXE AFTER MOVING TO ACS 1.1.6 
APAR SE65668  OSP-INCORROUT DDS OVERLAY OR WINDOW MENU LETTERS FROM THE 
SCREEN UNDERNEATH DISPLAY IN THE ACTIVE MENU 
APAR SE65694  OSP-INCORROUT-ACCESS CLIENT SOLUTIONS APW FORM FEED OCCURRING 
IN BOX / FRAME WHEN PRINTING 
APAR SE65695  OSP-INCORROUT STRPCCMD DOESN'T WORK WHEN USING %TEMP% 
APAR SE65712  OSP-UNPRED 5250 SESSION PAGE OVERLAYS BLEED THROUGH 
APAR SE65717  OSP-INCORROUT ACS OIA INDICATOR CAN'T CHANGE TO JAPANESE KANA 
ZENKAKU IF CUSTOMER PUTS THE CURSOR ON DBCS CHARACTER (O-FIELD). 
APAR SE65733  OSP-UNPRED ACS DATA TRANSFER REMOVES PRECEDING BLANKS WHEN FILE 
TYPE IS SET TO MICROSOFT EXCEL 2007-2010(.XLSX) 
APAR SE65734  OSP-UNPRED BACKGROUND SCREEN BLEEDS THROUGH WINDOW SCREEN 
APAR SE65736  OSP-INCORROUT-ACCESS CLIENT SOLUTIONS UNABLE TO PRINT TO FUJI 
XEROX PRINTER WITH CUSTOM PDT FROM XEROX 
APAR SE65749  OSP-UNPRED STRANGE BEHAVIOR CHARACTER INPUT BY MS-IME 
APAR SE65751  OSP-UNPRED THE ACS DOWNLOAD TO ASCII TEXT IS NOT HANDLING THE 
POSITIONS FOR THE SIGN WELL. 
APAR SE65754  OSP-INCORROUT ACCESS CLIENT SOLUTIONS CPI / SPACING INCORRECT 
USING IBM 5577 PDT 
APAR SE65757  OSP-INCORROUT ACCESS CLIENT SOLUTIONS SPOOLED FILE SPACING / 
CPI DIFFERENT WHEN PRINTING SPOOLED FILE 
APAR SE65759  OSP-INCORROUT ACCESS CLIENT SOLUTIONS LETTERS PRINT LOWER ON 
PAGE THROUGH ACS PRINTER SESSION USING IBMK14YOKO PAGES PDT 
APAR SE65769  OSP-UNPRED SO/SI GENERATE FUNCTION NOT AVAILABLE 
APAR SE65770  OSP-UNPRED SI CHARACTER IS REMOVED WHEN FIELD-EXIT IS USED WHEN 
THE CURSOR IS AT THE LEFT END OF THE FIELD 
APAR SE65771  OSP-UNPRED TYPING SINGLE BYTE CHARACTER WITH AUTOMATIC IME ON 
DOES NOT WORK 
APAR SE65774  INCORROUT DATA TRANSFER UPLOAD FAILS FROM XLSX WITH HOST FIELD 
TYPE: DECIMAL, CLIENT FIELD TYPE: DATE USING ACS LOCALE JA_JP 
APAR SE65786  OSP-PERFM ACS DATA TRANSFER IS USING A STATIC SCROLLABLE 
CURSOR. 



APAR SE65799  OSP-INCORROUT ACS 5250 SESSION FAILS TO CONNECT WITH SSL 
ENABLED. 
APAR SE65800  OSP-INCORROUT ACCESS CLIENT SOLUTIONS ONLY HALF PAGE PRINTED 
WHEN PRINTING THROUGH PRINTER SESSION USING IBMK14TATE PDT FILE 
APAR SE65813  OSP-UNPRED SI/SO GENERATE OPTION INCORRECTLY WORKS ON FIELD 
TYPES J AND W 
APAR SE65824  OSP-MSGCPF5411 QUERY WITH ENCRYPTED DATA RESULTS IN CPF5411 
APAR SE65844  OSP-UNPRED WHEN DDS MOUBTN IS BEING USED, DEFINED FOR RIGHT 
DOUBLE CLICK DOES NOT WORK CORRECTLY 
APAR SE65846  OSP-INCORROUT POPUP WINDOW DOES NOT HAVE A COMPLETE BORDER 
APAR SE65847  OSP-INCORROUT MIGRATING .WS FILE SHOWS SUCCESSFUL. NEW .HOD 
FILE NOT CREATED 
APAR SE65858  OSP-INCORROUT ACCESS CLIENT SOLUTIONS APW GRID LINE NOT 
PRINTING CORRECTLY WIHT PDT IBM5577 - B02 F02 G02 H02 
APAR SE65882  OSP-INCORROUT NUMERIC FIELDS ARE LEFT ALIGNED AFTER DATA 
TRANSFER, SO NO LEADING SPACES 
APAR SE65883  OSP-INCORROUT EHLLAPI PROGRAM RECEIVES INVALID DATA WITH ACS 
SESSION HOST CODEPAGE 939 
APAR SE65901  OSP-PERFM ACS WHERE CLAUSE CALLDBMAINTFOROPENOROPTIMIZE PARENS 
INCORRECT SQL STMT DATA TRANSFER 
APAR SE65952  OSP-UNPRED LARGE DATA-TRANSFER FROM A REMOTE SYSTEM CRASHES 
APAR SE65973  OSP-INCORROUT GRID LINE NOT PRINTING IN EXPECTED AREA USING 
XEROX PDT FILE 
APAR SE65975  OSP-INCORROUT ACCESS CLIENT SOLUTIONS FONT SIZE AND SPACING 
INCORRECT WITH IBM5577 PDT 
APAR SE65991  OSP-INCORROUT ACCESS CLIENT SOLUTIONS GRID LINES PRINT 
INCORRECTLY USING IBM5587 PDT 
APAR SE66005  OSP-UNPRED ENDING ACS DATA TRANSFER ENDS ALL SESSIONS TOO 
APAR SE66105  OSP-INCORROUT ACCESS CLIENT SOLUTIONS UNABLE TO PRINT TO FILE 
USING QWPDEFAULT WSCST OBJECT 
APAR SE66136  OSP-MSGGEN005-MSGGEN001 ISSUED WHEN DOWNLOADING SPOOLED FILES 
THROUGH ACCESS CLIENT SOLUTIONS PRINTER OUTPUT 
--------------------------------- 
Service Pack Level = LCD8-2010-13 
Build date = July 2016 
--------------------------------- 
The following features have been added: 
1. Integrated File System (IFS): 
   - Copy/Paste files between IBM i partitions 
   - Send files to multiple IBM i partitions 
   - Download/Upload files to/from PC 
   - Other actions include New Folder, Delete, Rename, Properties 
2. Enhancements to 5250 emulation: 
   - Smart card enablement on Windows for SSL client authentication 
3. Enhancements to SQL Performance Center: 
   - Visual Explain 
   - Compare 
   - SQL plan cache tab 
   - Show Statements for both the SQL plan cache and saved data 
4. Enhancements to Run SQL Scripts: 
   - Visual Explain integration 
   - JDBC Configuration Manager 
   - Job Log Viewer 
   - SQL Details for Job 
   - Global Variables and Special Registers tab 
   - Enhanced messages pane 
   - SQL Formatter 



5. Enhancements to Data Transfer: 
   - Support for character and numeric truncation 
   - Support for including column names/headings when downloading to text 
file types  
   - Usability improvements to Create IBM i DB File wizard 
   - Enablement for Active Calc Spreadsheet on Mac 
   - Ability to override default sheet name during download 
6. Deployment/Install: 
   - Support for silent mode when used in combination with /AdminConfig 
   - Multi-user installation on Windows 
   - Ability to restrict the Printer Output filter to Current user  
7. Several fixes including: 
 
APAR SE62793  OSP-INCORROUT MSGDB0036 DATA TRUNCATION WITH ACS DATA TRANSFER                                                                    
APAR SE64279  OSP-INCORROUT SECURE CONNECTION THAT FIRST CONNECT TO AS-RMTCMD 
TO DOWNLOAD 
              APP ADMIN DATA DOESN'T PROMPT FOR SSL CA CERT TRUST   
APAR SE64599  OSP-INCORROUT ACSLAUNCH_WIN-64.EXE IS REMOVING THE EXTRA SPACES 
WHEN USING 
              STRPCCMD                                               
APAR SE64607  OSP-UNPRED ACCESS CLIENT SOLUTIONS, DEFAULT PRINTER                                                                               
APAR SE64623  OSP-INCORROUT ACS DATA TRANSFER TO SOURCE PHYSICAL FILE                                                                           
APAR SE64633  OSP-INCORROUT ACS RUN SQL SCRIPT FAILS WITH PARSING ERROR WHEN 
NESTED CASE 
              IS USED IN AN EXPRESSION                              
APAR SE64697  OSP-INCORROUT ACS DB CREATION WIZARD FOR NEW FILE TRANSFER WILL 
NOT HANDLE 
              DECIMAL PLACES CORRECTLY.                              
APAR SE64705  OSP-THREADS-UNPRED DESTINATION ADDRESS" SETTING IN .HOD USING 
IP ADDRESS FOR 
              NAMED CONNECTION                                   
APAR SE64719  OSP-UNPRED GRDLIN DISAPPEARS BY SCREEN TRANSITION                                                                                 
APAR SE64763  OSP-UNPRED COPY/PASTE OF A DATE IS INCORRECTLY DONE                                                                              
APAR SE64774  OSP-INCORROUT ACS DISPLAY SESSION / COPY AS IMAGE WITH SCREEN 
SIZE 27X132 
              CONTAINS IMAGE FROM A PREVIOUS SCREEN                 
APAR SE64796  OSP-UNPRED UNABLE TO CREATE ACS PRINTER SESSION WITH HOST PRINT 
TRANSFORM 
              SET TO NO                                               
APAR SE64861  OSP-INCORROUT ACS FILE SCAN PRODUCES INCORRECT FDFX FILE                                                                          
APAR SE64865  OSP-INCORROUT ACS COPY PASTE OF HEX VALUES LIKE 0X01 ETC. WITH 
CRASH OEM APP                                                     
APAR SE64870  OSP-INCORROUT ACS HOD FILE MODIFIED VIA NOTEPAD EDITOR WILL NO 
LONGER BE 
              RECOGNIZED AS A VALID CONFIGURATION FILE             
APAR SE64925  OSP-INCORROUT ACS HMC CONSOLE JAPANESE SOFTWARE AGREEMENT WILL 
NOT BE 
              SHOWN CORRECTLY                                            
APAR SE64941  OSP-UNPRED CONSOLE BAR INCORRECT INFORMATION, NOT WORKING WELL 
TO MULTIPLE 
              PARTITIONS ON SAME SYSTEM                             
APAR SE64957  OSP-INCORROUT ACS PSHBTNCHC DID NOT WORK CORRECTLY                                                                                
APAR SE64968  OSP-UNPRED THE IBM I FIELD REFERENCE FILE NAME IS NOT CORRECT - 
THE IBM I FILE 
              NAME IS NOT CORRECT                                
APAR SE64972  OSP-UNPRED WINDOW SIZING WAS NOT CONSISTENT WHEN USING DUAL 
MONITORS                                                         



APAR SE65004  OSP-UNPRED COLUMN SEPARATOR SET TO LINE GOES THROUGH DBCS 
CHARACTERS                                                        
APAR SE65012  OSP-UNPRED INITIATE SQL DETAILS FROM ACS RUN SQL SCRIPTS NO 
DATA IS SHOWN 
              IN NAVIGATOR FOR I                                  
APAR SE65065  OSP-UNPRED OPEN SESSIONS IN A NEW TAB (UNCHECKED) PREFERENCE                                                                      
APAR SE65068  OSP-UNPRED ACS MSGGEN001 POSTED IF USER EXIT DENIES ACCESS                                                                        
APAR SE65073  OSP-UNPRED FIELDS FOR DISPLAY FILE NOT CLEARED WITH DBCS 
SESSION                                                                  
APAR SE65102  CA400XW1-INCORROUT IBM I ACCESS CLIENT SOLUTIONS 5250 EMULATOR 
HANGS WHEN 
              PASTING MORE THAN 1 LINE INTO FIELD WITH SCROLL BAR    
APAR SE65111  OSP-UNPRED ROWS ON SUBFILE ARE MISSING ON A 27X132 ACS SESSION                                                                    
APAR SE65144  OSP-UNPRED BLANKS ARE ADDED IN THE DOWNLOADED FILE WHEN DBCS 
CHARACTERS 
              ARE IN THE FIELD.                                      
APAR SE65147  OSP-INCORROUT "HOST FIELD: CHARACTER, CLIENT FIELD: NUMERIC" 
UPLOAD TO 
              IBM I FAILS WHEN WORKING IN A GERMAN ENVIRONMENT        
APAR SE65167  OSP-UNPRED ALIGNMENT NOT CORRECT FOR DOWNLOAD TO A TEXT FILE                                                                      
APAR SE65195  OSP-INCORROUT ACS FILE TRANSFER WITH NONE US ASCII TEST FILES 
WILL NOT WORK 
              DUE TO COMMA AS DECIMAL SEPARATOR                   
APAR SE65212  OSP- WINDOWS DEFAULT PRINTER ALWAYS USED WHEN JAVA PRINT 
SERVICE IS YES 
              IN ACS PRINTER SESSION                             
APAR SE65215  OSP-INCORROUT CURSOR DOES NOT MOVE CORRECTLY WHEN PRESSING LEFT 
              ARROW KEY.                                                        
APAR SE65216  OSP-INCORROUT ERROR HAPPENS WHEN A HORIZONTAL SCROLL BAR IS 
ENABLED.                                                          
APAR SE65233  OSP-UNPRED GRID LINE NOT SHOWN AT THE TOP OF THE ACS 5250 
EMULATION SCREEN                                                  
APAR SE65244  OSP-INCORROUT DBCS CHARACTER IN OIA FIELD GET CHANGED 
IMPROPERLY WHEN 
              THE CURSOR IS MOVED ON THE DBCS FIELD.            
APAR SE65247  OSP- APW VERTICAL GRID LINE MISSING WHEN PRINTED THROUGH ACCESS 
CLIENT 
              SOLUTIONS 
APAR SE65253  OSP-INCORROUT TEXT COLOR IS INCORRECT WITH ACCESS CLIENT 
SOLUTIONS 
APAR SE65271  OSP-UNPRED WHEN DDS MOUBTN IS BEING USED, MOUSE CLICK DOES NOT 
WORK 
              CORRECTLY WITH HCP 939 
APAR SE65286  OSP-INCORROUT ACS EMULATION IS NOT WORKING CORRECTLY WITH 
MNEMONIC  
APAR SE65287  OSP-UNPRED ZONED DECIMAL VALUES IN FIELD ARE SET TO 0 INSTEAD 
OF SINGLE 
              NUMBERS 1 THROUGH 9 AFTER UPLOAD 
APAR SE65288  OSP-INCORROUT THE IBM I ACS 5250 EMULATOR MAY NOT CORRECTLY 
CLEAR THE 
              GRIDLINES (DDS KEYWORD GRDLIN) FROM A PREVIOUS SCREEN 
APAR SE65298  OSP-UNPRED ACS STREML3270 CPF5063 NEGATIVE RESPONSE 10050151 
APAR SE65309  OSP-UNPRED VIETNAMESE CHARACTERS MISSING FROM "CHARACTERS" IN 
KEYBOARD MAPPING 
APAR SE65325  OSP-ACCESS CLIENT SOLUTIONS (ACS) - APW DOTTED LINE NOT PRINTED 
THROUGH PRINTER SESSION 



APAR SE65347  OSP-INCORROUT ACS HCP1399 HOD BRIDGE INCORRECT CHARACTER 
CONVERSION USING EHLLAPI 
APAR SE65438  OSP-INCORROUT EXTRA PAGES PRINTED FOR DBCS SPOOLED FILE THROUGH 
ACCESS CLIENT SOLULTIONS PRINTER SESSION 
APAR SE65455  OSP-INCORROUT ACS DB CREATION WIZARD WILL NOT HONOR LAST ROW 
FOR XLSX SHEETS 
APAR SE65456  OSP-INCORROUT ACS DB CREATION WIZARD WILL ELECT WRONG SCALE FOR 
EXCEL SHEET 
APAR SE65459  OSP-INCORROUT ACS DATA TRANSFER DB CREATION WIZARD FROM ACTIVE 
SPREADSHEET WRONG NUMERIC SCALE 
APAR SE65467  OSP-INCORROUT ACS DATA TRANSFER DB CREATION WIZARD WILL CHOOSE 
WRONG FIELD TYPE FOR CELL WITH A FUNCTION 
APAR SE65478  OSP-INCORROUT ACS DATA TRANSFER FDFX FILE CREATED IN WRONG 
LOCATION 
APAR SE65487  OSP-INCORROUT TRAILING BLANKS PROBLEMS WHEN UPLOADING UTF-8 CSV 
FILE TO TYPE G DBCS-GRAPHIC DATA 
APAR SE65489  OSP-INCORROUT ACS DATA TRANSFER DB CREATION WIZARD WILL NOT 
HONOR LAST ROW OF XLS SHEET FOR FILED SIZE CALCULATION 
 
 
--------------------------------- 
Service Pack Level = LCD8-2010-12 
Build date = March 2016 
--------------------------------- 
The following features have been added: 
1. Printer Output: Additional actions for Hold, Release, Move, Delete, plus 
   several performance and usability enhancements. 
2. Enhancements to 5250 emulation including:  
   - Custom positioning of watermark 
   - New toolbar action for Printer Output 
   - Capability to specify the starting index for Workstation ID 
   - Grid Line support for DBCS PDT 
   - Usability improvements to printer output 
   - Capability to disable default right-mouse click 
3. Capability to easily check and monitor for product updates. 
4. Several fixes including: 
 
APAR SE62282  OSP-INCORROUT THE DBCS CHARACTERS ARE MISSING WITHIN THE PDT 
              SUPPORT. THE OUTPUT IS GARBAGE.                              
APAR SE63789  OSP-UNPRED MSGGEN003 - COULD NOT GET COOKIE FOR AUTHENTICATION   
              WHEN "NAVIGATOR FOR I" IS CLICKED WITH ACS 1.1.5 EIM CONFIGURED  
APAR SE63815  OSP-UNPRED COPY DBCS DATA FROM 5250 NOT CORRECTLY PLACED IN THE  
              CELLS OF A SPREADSHEET                                           
APAR SE63817  OSP-INCORROUT DDS 'PULLDOWN' MENU NOT RESPONSIVE TO MOUSE CLICK 
APAR SE63826  SBCS KANA INCORROUT PRINTING WITH HOST CODEPAGE 930, 939 & 1399 
              & CUSTOMIZED PDT COMPILED ON ACS. YIELDS UNEXPECTED RESULTS.    
APAR SE63863  OSP-INCORROUT LIBREOFFICE WILL DIE AFTER UPLOADING DATA FROM A 
              OPEN SPREADSHEET WITH ACS                                      
APAR SE63864  OSP-UNPRED RUN SQL SCRIPTS - SQL STATEMENT WITH CASE FAILS WITH 
              SQL0104                                                         
APAR SE63890  OSP-UNPRED ACS MACRO CREATION. HOST ACCESS MACRO          
              EDITOR=>SCREENS TAB. OPTION=FALSE CAUSED HANG CONDITION,  
APAR SE63898  OSP-PAR-940XCOM ACS PDT PRINT CREATE SAMPLES FOLDER IN IBM I     
              ACCESS CLIENT SOLUTIONS (32-BIT) 1.1.5.0 BUILD ID: 5492 IS 
EMPTY 
APAR SE64037  OSP-INCORROUT ACS SESSION HANGS CALLING PGM USING DDS FROM  
              DSPSIZ(24X80 *DS3) TO DSPSIZ(27X132 *DS4)                   



APAR SE64077  OSP-INCORROUT ACS SYSTEM DROP-DOWN LIST ON WRONG DISPLAY 
APAR SE64164  OSP-UNPRED HOST CODE PAGE 1148 BELGIUM NOT AVAILABLE  
APAR SE64168  OSP-THREADS-UNPRED ACS 5250 LINUX HANGS 
APAR SE64218  OSP-UNPRED FTP BATCH EXECUTED WITH STRPCCMD SHOWS NO RESPONSE 
              STATUS MESSAGES IN THE FTP LOG AND NO COMMAND WINDOW OPENED   
APAR SE64250  OSP-D/T5585-PAR-940XCOM PCOMM GRID LINE / MAGNIFIED APW / DDS  
              CHARACTERS IS NOT PRINTED USING PDT.                           
APAR SE64318  OSP-INCORROUT ACS WILL SHOW MSGDB0036 WHEN LIB IN THE LIBL 
              CONTAINS FRENCH                                            
APAR SE64420  OSP-INCORROUT ACS WILL NOT WORK CORRECTLY WITH DDS KEYWORD  
              ENTFLDATR                                                   
 
 
 
--------------------------------- 
Service Pack Level = LCD8-2010-11 
Build date = December 2015 
--------------------------------- 
The following updates have been added: 
1. Database options have been added to the main GUI for: 
   - Run SQL Scripts 
   - SQL Performance Center 
2. Enhancements to 5250 emulation including: 
   - keyboard customization "Search for Key" will display default keystroke 
   - URL hotspots that span multiple lines are allowed 
   - the scratch pad area can be resized 
3. Several fixes. 
 
--------------------------------- 
Service Pack Level = LCD8-2010-10 
Build date = October 2015 
--------------------------------- 
The following features have been added: 
1. Enhancements to the installation script for Windows so administrators can 
   more easily customize and deploy an installation. 
2. Enhancements to 5250 emulation including: 
   - Add more raster fonts from PCOMM 
   - Migration utility should recognize kmp & pmp file types 
   - PDT support for DBCS 
3. Several fixes including: 
 
APAR SE62629  OSP-WAIT .HOD FILE NEVER OPENS WHEN LAUNCHING AFTER .BAT FILE  
              THAT DOES /PLUGIN=LOGON 
 
APAR SE62715  OSP-INCORROUT STICKY POPUP PAD DOES NOT SYNC WHEN CHANGED 
 
APAR SE62736  OSP-INCORROUT ACS HLLAPI PCSQUERYWORKSTATIONPROFILE RESULTS DO 
              NOT INCLUDE PATH                                                
 
APAR SE62805  OSP-INCORROUT NUMERIC DATA IN ROW X, COLUMN X HAS TOO MANY       
              DIGITS FOR THE IBM I FIELD (XXXXX). MAXIMUM VALUE WILL BE USED 
 
APAR SE62816  OSP-THREADS-UNPRED ACS 5250 EMULATOR INDENTATION ISSUE 
 
APAR SE62853  OSP-INCORROUT WHEN HOTSPOT URL 3D BUTTON IS SELECTED FILE: 
              SHOWS AS A HOTSPOT AND OPENS WINDOWS EXPLORER.             
 



APAR SE62937  OSP-UNPRED THE FPN HOTSPOT BUTTON APPEARS IN THE MIDDLE OF A 
WORD 
 
-------------------------------- 
Service Pack Level = LCD8-2010-09 
Build date = July 2015 
--------------------------------- 
The following features have been added: 
1. Installation Script for Windows 
2. Enhancements to 5250 emulation including: 
   - Change default behavior for <ctrl>right 
   - Add Command+t for creating a new tab on Mac 
   - Add FieldExit+Enter as a new keyboard Host Function 
3. Several fixes including: 
 
APAR SE62296  OSP-INCORROUT STRPCCMD FAILS WHEN COMMAND HAS EMBEDDED SPACES  
 
APAR SE62313  OSP-UNPRED ERROR JAVA.LANG.ARRAYINDEXOUTOFBOUNDSEXCEPTIONSTACK   
              SAVING SESSION WHEN LOCALE JA_JP IS SET                          
 
APAR SE62333  OSP-UNPRED JAVA EXCEPTION WHEN RUNNING ACSLAUNCH_WIN-32.EXE OR   
              ACSLAUNCH_WIN-64.EXE OVER UNC PATH.                              
 
 
--------------------------------- 
Service Pack Level = LCD8-2010-08 
Build date = April 2015 
--------------------------------- 
 
APAR SE61488  OSP-INCORROUT KEYBOARD MAPPING NOT MIGRATED TO ACS CLIENT KMP 
              FILE FROM IAWIN KMP FILE.                                     
 
APAR SE61539  OSP-INCORROUT WHEN USING THE DUP KEY FIELD PROCESSING GET AN     
              ERROR "ENTER KEY NOT ALLOWED IN THIS FIELD".                     
 
APAR SE61599  OSP-INCORROUT PROMPTED FOR SIGNON IN KERBEROS CONFIGURED HOD   
              SESSION, AFTER DISCONNECT AND RESIGNON.                        
 
APAR SE61611  OSP-INCORROUT DATA TRANSFER FILE MIGRATION FROM IAWIN TO ACS     
              FAILS: THE FILE TYPE OF THE REQUEST IS UNSUPPORTED OR NOT 
VALID. 
 
APAR SE61637  OSP-INCORROUT KEYBOARD MAPPING INCORRECT KEY SHOWS UNKNOWN  
              KEYCODE 0X0                                                 
 
--------------------------------- 
V1R1M4 GA    Level = LCD8-2010-07 
Build date = February 2015 
--------------------------------- 
 
The following features were added for V1R1M4: 
 
1. Several enhancements to 5250 emulation including: 
   - tabbed sessions that share a common presentation space 
   - save a view of multiple sessions for easy restart of multiple sessions 
   - additional watermark customizations  
   - ability to add user provided fonts 



   - migration wizard for .ws profiles 
   - support for Host Code pages: 1130, 1132, 1164 & 1377 
   - optional input character validation based on host code page  
   - print emulation enhancements 
   - additional mouse wheel customizations 
   - cursor customization when doing a paste 
   - additional keyboard mapping options: 
     Character Backspace, Character Advance, APL screen attributes 
   - maximum sessions allowed has been increased to 52 
2. HMC Probe Utility for finding all partitions managed by an HMC 
3. /file option added to RMTCMD allowing multiple commands  
4. Easier deployment and setup for Mac and Linux 
5. QuickStartGuide for Windows, Mac & Linux 
6. GettingStarted reformatted in html (English only)  
7. Several fixes including: 
 
APAR SE60944: OSP-UNPRED COLUMN SEPARATOR AS LINE INCORRECT WITH HCP 939  
 
APAR SE61324  OSP-INCORROUT PC5250 .WS MIGRATED TO .HOD AND USER IS PROMPTED  
              FOR SIGNON WHEN SESSION CONFIGURED FOR KERBEROS AUTHENTICATION. 
 
 
--------------------------------- 
Service Pack Level = LCD8-2010-06 
Build date = October 2014 
--------------------------------- 
 
APAR SE59743: OSP-WAIT ACS TRANSFER TO EXCEL PAUSES WHEN COMPLETE  
 
APAR SE59986: OSP-INCORROUT ACS TRANSFER TO OPEN SPREADSHEET WITH NETWORK 
              DRIVE                                                        
  
--------------------------------- 
Service Pack Level = LCD8-2010-05 
Build date = July 2014 
--------------------------------- 
 
APAR SE59497: UNPRED-HLIC PRINTING TO LOCAL PRINTER VIA ACS ON AN UBUNTU   
              LINUX 14.4 SYSTEM RESULTS IN NO OUTPUT AND NO OBVIOUS ERROR 
               
APAR SE58786: OSP-MSGCPF5411-PAR-940XCOM ACS 5250 SESSION FAILS WITH CPF5411   
              FEEDBACK CODE 00002501 ON SCREEN WITH MORE THAN 256 INPUT 
FIELDS  
 
APAR SE59260: UNPRED-HLIC-94XXMISC IF ONE SESSION IS DOING A RUNQRY COMMAND,   
              THEN ALL OTHER SESSIONS ARE LOCKED 
               
APAR SE59391: OSP-UNPRED DDS DISPLAY FILES RESPONSE INDICATOR FOR CHANGE       
              KEYWORD REMAINS *ON AFTER THE FORMAT IS REDISPLAYED              
 
--------------------------------- 
Service Pack Level = LCD8-2010-04 
Build date = March 2014 
--------------------------------- 
 
APAR SE57901: OSP-INCORROUT TRIMRECTANGLEREMAINAFTEREDIT IS NOT 
              SET CORRECTLY WHEN IMPORTING WORKSTATION FILE                                  



                   
APAR SE58392: OSP-INCORROUT INCOMPLETE DATA TRANSFER USING ACCESS 
              CLIENT SOLUTIONS WITH XLS FILE                                          
 
                                                       
--------------------------------- 
Service Pack Level = LCD8-2010-03 
Build date = January 2014 
--------------------------------- 
 
APAR SE57584: OSP-F/QJVAUTLJVM-T/QUOCMD-RC1-MSGJVA0122 JAV0122 
              RC1 IS RECEIVED WHEN A USER DOES ACS DATA TRANSFER 
              USING RUNJVA  
 
       
--------------------------------- 
Service Pack Level = LCD8-2010-02 
Build date = October 2013 
--------------------------------- 
 
APAR SE56526: OSP-INCORROUT ACS DATA TRANSFER UPLOAD FAILS WHEN USING  
              FORMATTED NUMERIC FIELDS IN .XLS FORMAT                  
 
APAR SE56609: OSP-UNPRED ACS SPOOL FILE IN TEXT FORMAT WONT OPEN IN GEDIT 
              LINUX ENVIRONMENT.                                          
 
APAR SE56738: OSP-UNPRED WHEN ADDING A NEW BUTTON TO THE 5250 EMULATOR TOOL 
              BAR, IT DOES NOT ALLOW THE ICON TO BE CHANGED                 
 
 
------------------------------------------------------------------- 
[END OF DOCUMENT] 

 


